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MOTTO 

 

 

“Dan Apabila Kamu Telah Membulatkan Tekad, Maka 

Bertawakallah Kepada Allah" (QS. Ali Imran: 159) 

 

 

 

“Where There Is A Will There Is A Way” 

 

 

 

“Miracle Will Happen As You Embrace Your Hope” 

~Daesung BIGBANG~ 
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ABSTRAK 

 

 
Penelitian ini bertujuan untuk mengetahui distribusi nilai anomali medan 

magnet pada daerah manifestasi panas bumi Tinatar-Karangrejo, mengidentifikasi 

struktur litologi bawah permukaan daerah manifestasi panas bumi Tinatar-

Karangrejo, serta mengidentifikasi pengaruh keberadaan Sesar Tinatar dan Sesar 

Grinjing terhadap kemunculan manifestasi panas bumi Tinatar-Karangrejo. 

Penelitian ini dilakukan di daerah manifestasi panas bumi Tinatar-Karangrejo 

yang berada pada koordinat geografis 8°4’53,1’’ hingga 8°8’4,6’’ LS dan 

111°4’10,7’’ hingga 111°8’32,1’’ BT dengan jumlah titik penelitian sebanyak 54 

titik. Pengambilan data primer dilakukan pada tanggal 21-23 Agustus 2017 

menggunakan Proton Precession Magnetometer (PPM). Pengolahan data yang 

dilakukan adalah koreksi IGRF, koreksi variasi harian, reduksi ke kutub, kontinuasi 

ke atas, pemodelan 2D, serta pemodelan 3D.  

Dari hasil analisis data diketahui bahwa nilai anomali medan magnet di 

daerah penelitian berkisar antara -420 nT hingga 180 nT. Batuan beku vulkanik 

merupakan batuan dasar daerah penelitian yang berada pada kedalaman 0−2100 m 

dengan kisaran nilai suseptibilitas 0 hingga 75,6 × 10-3 (dalam SI). Di atas batuan 

beku vulkanik terdapat batuan piroklastik  yang berada pada kedalaman 0−1700 m  

dan memiliki nilai suseptibilitas 0 hingga 7,7 × 10-3 (dalam SI). Pada bagian paling 

atas terdapat batuan sedimen klastik yang berada pada kedalaman 0−471 m dan 

memiliki nilai suseptibilitas 0 hingga 0,8 × 10-3 (dalam SI) dan batuan metamorf 

yang berada pada kedalaman 0−570 m dan memiliki nilai suseptibilitas 0,35 hingga 

1,58 × 10-3 (dalam SI). Sesar Tinatar dan Sesar Grinjing berperan sebagai jalan 

keluarnya air panas ke permukaan. 

 

 

Kata kunci: metode geomagnet, manifestasi panas bumi, Tinatar-Karangrejo 
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ABSTRACT 

 

 

This study aimed to determine the distribution of magnetic field anomalies in 

Tinatar-Karangrejo geothermal manifestation area, to identify lithological structure 

of the subsurface of Tinatar-Karangrejo geothermal manifestation area, and to 

identify the role of Tinatar Fault and Grinjing Fault to the rise of Tinatar-Karangrejo 

geothermal manifestation. 

This study conducted in Tinatar-Karangrejo geothermal manifestation area 

which is located at the geographical coordinates of 8°4’53,1’’ S to 8°8’4,6’’ S and 

111°4’10,7’’ E to 111°8’32,1’’ E with 54 measurement points. Primary data 

measurement had been done on August 21-23, 2017 using Proton Precession 

Magnetometer (PPM). Magnetic data then processed using IGRF correction, 

diurnal correction, reduce to the pole (RTP) transformation, upward continuation 

transformation, 2D modelling, and 3D modelling. 

The result of data analysis showed that the magnetic field anomalies in the 

study area ranged from -420 nT to 180 nT. Volcanic igneous rocks are the bedrocks 

of the study area which are at a depth of 0-2100 m below the surface with 

susceptibility ranged from 0 to 75,6 × 10-3 (SI unit). Above the volcanic igneous 

rocks, there are pyroclastic rocks which are at a depth of 0-1700 m below the surface 

with susceptibility ranged from 0 to 7,7 × 10-3 (SI unit). At the very top, there are 

clastic sedimentary rocks which are at a depth of 0-471 m with susceptibility ranged 

from 0 to 0,8 × 10-3 (SI unit) and metamorphic rocks which are at a depth of 0-570 

m below the surface with susceptibility ranged from 0,35 to 1,58 × 10-3 (SI unit). 

Tinatar fault and Grinjing fault act as the pathway for geothermally heated water to 

rise to the surface. 

 

 

 

Keywords: geomagnetic method, geothermal manifestation, Tinatar-Karangrejo 
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BAB I 

PENDAHULUAN 

 

A. Latar Belakang  

Indonesia merupakan salah satu negara yang dari segi geografis terbilang unik 

karena berada di pertemuan tiga lempeng utama bumi, yaitu Lempeng Eurasia, 

Lempeng Indo-Australia, dan Lempeng Pasifik. Lempeng Indo-Australia 

bertabrakan dengan Lempeng Eurasia di lepas pantai Sumatra, Jawa, dan Nusa 

Tenggara seperti ditunjukkan pada Gambar 1. Lempeng Indo-Australia yang 

merupakan lempeng samudra menunjam di bawah Lempeng Eurasia yang 

merupakan lempeng benua. Hal ini dikarenakan  densitas lempeng samudra lebih 

besar daripada lempeng benua. Zona penunjaman ini disebut zona subduksi. 

 
Gambar 1. Peta Lempeng Tektonik di Asia Tenggara  (Hall, 2002). 
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Keberadaan zona subduksi tersebut menyebabkan pulau-pulau di Indonesia 

yang berada di dekatnya memiliki struktur geologi yang kompleks, seperti 

banyaknya gunung api, sesar, cekungan, dan lapisan sedimen seperti ditunjukkan 

pada Gambar 2.  

 
Gambar 2. Penunjaman Lempeng Samudra pada Zona Subduksi dan Pembentukan    

Struktur- Struktur Geologi (Turcotte & Schubert, 1982). 

 

 

Karena banyaknya gunung api dan letak geografisnya yang unik ini, 

Indonesia dikatakan berada di daerah ring of fire, yaitu daerah yang berada di dekat 

pertemuan lempeng pasifik dan lempeng-lempeng di sekitarnya serta merupakan 

daerah yang aktif secara seismologi dan vulkanologi (USGS, 1999). Daerah ring of 

fire ditunjukkan pada Gambar 3. Daerah ring of fire umumnya kaya akan potensi 

panas bumi. Menurut Condie (1997), mineral yang umum ditemukan di daerah ring 

of fire adalah hidrotermal, porfiri, dan sulfida, sedangkan potensi energi yang 

tersimpan adalah berupa panas bumi dan hidrokarbon. Hal ini berlaku di Indonesia 

yang termasuk dalam daerah ring of fire sehingga kaya akan potensi energi panas 

bumi dan hidrokarbon. 
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Gambar 3. Peta Daerah Ring of Fire (USGS, 1999). 

 

Indonesia merupakan salah satu negara dengan potensi panas bumi terbesar 

di dunia. Menurut Wardani (2017), terdapat 331 titik potensi panas bumi yang 

tersebar mengikuti formasi vulkanik dari Sumatra, Jawa, Bali, Nusa Tenggara 

hingga Maluku dengan rincian cadangan (reserve) sebesar 17.506 MW dan sumber 

daya (resources) sebesar 11.073 MW. Potensi panas bumi ini ditandai dengan 

adanya manifestasi panas bumi, yaitu gejala di permukaan yang merupakan ciri 

terdapatnya potensi energi panas bumi di bawah permukaan daerah. Manifestasi 

panas bumi dapat berupa mata air panas, fumarole, tanah beruap, tanah hangat, dan 

lain-lain (BSNI, 1998). 

Salah satu pulau di Indonesia yang paling besar potensi panas buminya adalah 

Pulau Jawa. Di Pulau Jawa sendiri setidaknya terdapat 62 titik berpotensi (Setidjati 

dalam Purnomo & Pichler, 2014). Persebaran daerah potensi panas bumi di Pulau 
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Jawa ditunjukkan pada Gambar 4. Menurut Alam et al. dalam Purnomo & Pichler 

(2014), daerah panas bumi di Pulau Jawa berdasarkan asosiasi geologinya dapat 

dibagi menjadi dua sistem panas bumi, yaitu sistem panas bumi yang berhubungan 

dengan kompleks vulkanik dan sistem panas bumi yang berhubungan dengan zona 

sesar. Hingga tahun 2014, tujuh lapangan panas bumi  yang berhubungan dengan 

kompleks vulkanik di Pulau Jawa telah dikembangkan, sedangkan daerah panas 

bumi yang berhubungan dengan zona sesar sendiri belum banyak diteliti dan 

dikembangkan. 

 
Gambar 4. Persebaran Daerah Potensi Panas Bumi di Pulau Jawa (Purnomo & 

Pichler, 2014). 

 

 

Daerah potensi panas bumi di Pulau Jawa yang berhubungan dengan zona 

sesar salah satunya adalah daerah potensi panas bumi di Kabupaten Pacitan 

(Purnomo & Pichler, 2014). Di Kabupaten Pacitan terdapat dua daerah manifestasi 

panas bumi yang terasosiasi dengan sesar dan belum banyak diteliti, yaitu 

manifestasi panas bumi Tinatar berupa mata air panas Tinatar yang terletak di Desa 

Tinatar Kecamatan Punung dan manifestasi panas bumi Karangrejo berupa mata air 

panas Tirta Husada yang terletak di Desa Karangrejo Kecamatan Arjosari. Menurut 
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Akbar et al. (1993), manifestasi panas bumi Tinatar dan manifestasi panas bumi 

Karangrejo memiliki sumber panas yang sama. Oleh karena itu, pada penelitian ini 

disebut sebagai manifestasi panas bumi Tinatar-Karangrejo. 

Adapun penelitian yang pernah dilakukan di daerah manifestasi panas bumi 

Tinatar-Karangrejo antara lain penyelidikan geokimia panas bumi Tinatar-

Karangrejo oleh Badrudin et al. (1993), penyelidikan geologi panas bumi Tinatar-

Karangrejo oleh Akbar et al. (1993), penelitian geologi untuk menganalisis tegasan 

purba di daerah Pacitan berdasarkan studi sesar minor dan kekar tektonik oleh 

Abdullah et al. (2003), penelitian geofisika metode geomagnet di daerah 

manifestasi panas bumi Karangrejo oleh Lestari (2015) dan penelitian geofisika 

metode geomagnet dengan target Sesar Minor Grindulu yang letaknya dekat dengan 

daerah manifestasi panas bumi Karangrejo oleh Nurrohman (2016). 

Meskipun telah dilakukan penelitian geologi dan geokimia di daerah 

manifestasi panas bumi Tinatar-Karangrejo, belum ada penelitian geofisika yang 

mencakup dua daerah manifestasi panas bumi tersebut. Padahal daerah manifestasi 

panas bumi Tinatar-Karangrejo memiliki sumber panas yang sama, sehingga 

diperlukan penelitian yang daerah targetnya mencakup kedua daerah tersebut.  

Penelitian geofisika sendiri berfungsi untuk memetakan perkiraan susunan 

lapisan-lapisan bawah permukaan berdasarkan sifat fisis batuan sehingga dapat 

melengkapi penelitian geologi dan geokimia. Di antara metode penyelidikan 

geofisika yang dapat digunakan untuk memetakan daerah panas bumi adalah 

metode geomagnet, dimana dalam metode geomagnet besaran yang diukur adalah 

nilai medan magnet total di suatu daerah dimana anomali hasil pengukuran medan 
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magnet dipengaruhi oleh kerentanan magnet (suseptibilitas) batuan di bawah 

permukaan daerah tersebut. Nilai suseptibilitas batuan inilah yang kemudian 

diinterpretasikan untuk mengetahui jenis-jenis batuan penyusun bawah permukaan. 

Metode geomagnet ini umumnya digunakan untuk mempelajari adanya 

intrusi batuan beku, batuan dasar, zona mineralisasi hidrotermal yang kaya akan 

mineral ferromagnet, dan struktur geologi. Metode geomagnet ini digunakan pada 

studi panas bumi karena mineral-mineral ferromagnet akan kehilangan sifat 

kemagnetannya bila dipanasi mendekati temperatur Curie (Broto & Putranto, 

2011). Oleh karena itu, penelitian ini menggunakan metode geomagnet untuk 

mengidentifikasi litologi bawah permukaan daerah manifestasi panas bumi Tinatar-

Karangrejo.  

 

B. Identifikasi Masalah 

Berdasarkan latar belakang masalah di atas maka dapat diidentifikasi masalah 

sebagai berikut: 

1. Kurangnya penelitian daerah potensi panas bumi yang berhubungan dengan 

zona sesar. 

2. Manifestasi panas bumi Tinatar dan Karangrejo memiliki sumber panas yang 

sama, namun belum adanya penelitian geofisika yang daerah penelitiannya 

mencakup daerah kedua daerah manifestasi tersebut. 

3. Diperlukannya penelitian untuk dapat menganalisis pengaruh keberadaan Sesar 

Tinatar dan Sesar Grinjing terhadap kemunculan manifestasi panas bumi 

Tinatar-Karangrejo. 
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C. Batasan Masalah 

Batasan masalah pada penelitian ini adalah sebagai berikut: 

1. Daerah penelitian hanya di sekitar manifestasi panas bumi Tinatar-Karangrejo 

dan terletak pada koordinat 8°4’53,1’’ hingga 8°8’4,6’’ LS dan 111°4’10,7’’ 

hingga 111°8’32,1’’ BT. 

2. Metode untuk akuisisi data menggunakan looping yaitu dengan menggunakan 

satu set alat PPM yang berfungsi sebagai base dan rover.  

3. Karakteristik panas bumi yang dianalisis adalah formasi batuan penyusun bawah 

permukaan daerah manifestasi panas bumi serta analisis pengaruh sesar-sesar di 

sekitar manifestasi panas bumi berdasarkan anomali medan magnet yang 

tersebar di daerah penelitian dan ditunjang dengan adanya peta geologi untuk 

memodelkan penampang bawah permukaannya. 

  

D. Rumusan Masalah 

Berdasarkan latar belakang masalah di atas, perumusan masalah penelitian 

adalah sebagai berikut: 

1. Bagaimana distribusi nilai anomali medan magnet pada daerah manifestasi 

panas bumi Tinatar-Karangrejo? 

2. Bagaimana struktur litologi bawah permukaan daerah manifestasi panas bumi 

Tinatar-Karangrejo? 

3. Bagaimana pengaruh keberadaan Sesar Tinatar dan Sesar Grinjing terhadap 

kemunculan manifestasi panas bumi Tinatar-Karangrejo? 
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E. Tujuan Penelitian 

Tujuan penelitian yang dilakukan adalah sebagai berikut: 

1. Mengetahui distribusi nilai anomali medan magnet pada daerah manifestasi 

panas bumi Tinatar-Karangrejo. 

2. Mengidentifikasi struktur litologi bawah permukaan daerah manifestasi panas 

bumi Tinatar-Karangrejo. 

3. Mengidentifikasi pengaruh keberadaan Sesar Tinatar dan Sesar Grinjing 

terhadap kemunculan manifestasi panas bumi Tinatar-Karangrejo. 

 

F. Manfaat Penelitian 

Dari penelitian ini diharapkan dapat memberi manfaat sebagai berikut: 

1. Menambah referensi penelitian daerah manifestasi panas bumi yang 

berhubungan dengan zona sesar. 

2. Memberikan informasi tentang litologi bawah permukaan daerah manifestasi 

panas bumi Tinatar-Karangrejo yang dapat dijadikan sebagai gambaran struktur 

bawah permukaan  daerah tersebut. 

3. Memberikan informasi keberadaan dugaan Sesar Tinatar dan Sesar Grinjing. 
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BAB II 

KAJIAN PUSTAKA 

 

A. Teori Kemagnetan 

1. Suseptibilitas dan Permeabilitas Magnet 

Suseptibilitas (k) adalah sebuah besaran tak berdimensi yang menyatakan 

sifat kemagnetan suatu material, atau ukuran kemampuan suatu material untuk 

dapat dimagnetisasi (Serway & Jeweet, 2004). Jika sebuah material 

bersuseptibilitas k diletakkan pada medan magnet eksternal dengan kuat medan 

magnet 𝐇, maka material tersebut akan terinduksi oleh medan magnet dan 

dikatakan memiliki intensitas magnetisasi M sebesar (Telford et al,. 2004): 

𝐌 = 𝑘𝐇  (1) 

dimana intensitas magnetisasi M dalam ampere per meter (A/m). 

Permeabilitas magnet 𝜇 adalah ukuran kemampuan suatu material untuk 

melewatkan fluks magnet yang melewatinya. Pada penerapannya, permeabilitas 

magnet sering dinyatakan dalam permeabilitas relatif 𝜇𝑟, dimana permeabilitas 

relatif 𝜇𝑟 adalah rasio permeabilitas magnet suatu material dengan permeabilitas 

ruang hampa: 

𝜇𝑟 =
𝜇

𝜇0
                                   (2) 

dengan 𝜇𝑜 adalah permeabilitas ruang hampa dengan nilai 4𝜋 × 10−7 Wb Am⁄ . 

Suseptibilitas magnet k memiliki hubungan dengan permeabilitas relatif 𝜇𝑟. 

Hubungan ini dapat dinyatakan sebagai: 

𝜇𝑟 = 1 + 𝑘                                                                                          (3) 
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Suseptibilitas magnet adalah parameter fisis dari batuan yang dicari pada 

metode geomagnet. Respons kemagnetan dari batuan dan mineral ditentukan oleh 

jumlah material dan suseptibilitas magnet material di dalam batuan dan mineral 

(Telford et al., 2004). 

2. Induksi Magnet 

Induksi magnet B adalah medan magnet total yang terbaca serta dipengaruhi 

oleh medan eksternal 𝐁0 dan medan anomali yang dihasilkan oleh material magnet 

(𝐁𝐦). Secara umum, persamaannya dapat dituliskan sebagai berikut (Serway & 

Jeweet, 2004): 

𝐁 = 𝐁0 + 𝐁𝐦  (4) 

dimana 𝐁𝐦 dapat didefinisikan sebagai: 

𝐁𝐦 = 𝜇0𝐌  (5)  

sedangkan 𝐁0 dapat didefinisikan sebagai,  

𝐁0 = 𝜇0𝐇  (6)  

Persamaan (5) dan (6) disubstitusikan ke dalam Persamaan (4) sehingga dapat 

diperoleh: 

𝐁 = 𝜇𝑜(𝐇 + 𝐌)        (7) 

Persamaan (1) disubstitusikan ke dalam Persamaan (7) menjadi: 

𝐁 = 𝜇𝑜(1 + 𝑘)𝐇 = 𝜇𝑜𝜇𝑟𝐇 (8) 

Dalam pengukuran geomagnet, B adalah medan magnet total yang terbaca 

oleh magnetometer, B0 adalah medan magnet utama bumi, dan 𝐁𝐦 adalah medan 

magnet hasil induksi medan magnet bumi pada material di kerak bumi yang 

memiliki suseptibilitas. 
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B. Medan Magnet Bumi 

1. Elemen-Elemen Medan Magnet Bumi 

Dari teori yang berkembang disebutkan bahwa medan magnet bumi 

disebabkan oleh adanya arus konveksi dari material konduktor pada inti luar bumi 

yang cair (yang terdapat pada kedalaman sekitar 2.800 hingga 5.000 km). Inti bumi 

diasumsikan merupakan gabungan besi dan nikel, dimana keduanya merupakan 

konduktor listrik yang baik. Sumber medan magnet ini dianggap seperti dinamo 

dimana fluida material yang memiliki konduktivitas tinggi ini bergerak secara acak 

karena adanya arus konveksi (Telford et al., 2004). Medan magnet bumi memiliki 

elemen-elemen dengan tiga arah utama yaitu elemen arah utara, elemen arah timur, 

dan elemen arah vertikal atau dalam koordinat Cartesius dinyatakan dalam X, Y, 

dan Z. Elemen-elemen tersebut adalah: 

a. Deklinasi (Declination) yaitu sudut antara utara magnet bumi dengan komponen 

horizontal yang dihitung dari utara menuju timur (sudut antara utara magnet 

bumi dan utara geografis).  

b. Inklinasi (Inclination) yaitu sudut antara medan magnet total dengan bidang 

horizontal yang dihitung dari horizontal menuju ke bidang vertikal ke bawah 

(sudut antara bidang horizontal dan vektor medan total). 

c. Komponen horizontal (Horizontal Component) yaitu magnitudo dari medan 

magnet total pada arah horizontal. 

d. Medan magnet total (Total Field) yaitu magnitudo dari medan vektor magnet 

total. 

Hubungan dari elemen-elemen tersebut ditunjukkan oleh Gambar 5. 
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Gambar 5. Elemen-Elemen Medan Magnet Bumi (Campbell, 2003). 

 

2. Medan Magnet Utama 

Hampir 99% dari medan magnet yang terukur di permukaan bumi bersumber 

dari dalam bumi (Telford et al., 2004). Medan magnet yang bersumber dari dalam 

bumi ini disebut medan magnet utama bumi. Medan magnet utama bumi berubah 

terhadap waktu yang relatif berjalan lebih lambat atau disebut variasi sekuler. 

Untuk menyeragamkan nilai-nilai medan utama magnet bumi, dibuat standar nilai 

yang disebut International Geomagnetics Reference Field (IGRF) yang diperbarui 

setiap 5 tahun sekali. Nilai-nilai IGRF tersebut diperoleh dari hasil pengukuran rata-

rata pada daerah luasan sekitar 1 juta km2 yang dilakukan dalam waktu satu tahun. 

Nilai medan magnet ini ditentukan berdasarkan kesepakatan internasional di bawah 
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pengawasan International Association of Geomagnetic and Aeronomy (IAGA). 

Nilai IGRF ini dapat diperoleh dari website NOAA. 

3. Medan Magnet Luar 

Medan magnet luar adalah medan magnet yang bersumber dari luar tubuh 

bumi. Medan magnet ini menyumbang sebagian kecil dari total medan magnet bumi 

(± 1%) dan disebabkan oleh medan magnet yang muncul karena adanya arus listrik 

di ionosfer. Medan magnet ini bervariasi terhadap waktu dengan sangat cepat 

(Telford et al., 2004). Hal-hal yang mempengaruhi medan magnet luar adalah: 

a. Siklus 11 tahun sekali yang berhubungan dengan adanya bintik matahari 

(sunspot). 

b. Variasi harian matahari dengan periode 24 jam dan jangkauan hingga 30 nT yang 

bervariasi terhadap ketinggian lintang dan musim serta dipengaruhi oleh adanya 

angin matahari dan arus di ionosfer. 

c. Variasi harian bulan dengan periode 25 jam dan jangkauan 2 nT yang bervariasi 

secara siklik selama satu bulan dan dipengaruhi oleh interaksi bulan dengan 

ionosfer. 

d. Badai geomagnet, yaitu gangguan yang sifatnya sementara dengan jangkauan 

hingga lebih dari 1.000 nT.  Gangguan ini nilainya lebih besar di daerah kutub 

dan berhubungan dengan adanya aurora. Meskipun sifatnya acak, gangguan ini 

sering muncul setiap 27 hari sekali. Pada hari dimana badai geomagnet tinggi 

umumnya pengukuran geomagnet tidak bisa dilakukan. 

Karena pengaruhnya yang sangat besar ini, maka para ahli membuat indeks 

ukuran seberapa besar badai geomagnet yang terjadi dan dikenal dengan 
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Disturbance Storm Time Index (Indeks DST). Pengukuran DST dilakukan di  empat 

stasiun yang berlokasi di lintang rendah dan terdistribusi secara merata terhadap 

ekuator magnet, yaitu Hermanus, Kakioka, Honolulu, dan San Juan yang 

menghasilkan indeks DST skala global (INGV, 2015). Klasifikasi intensitas badai 

geomagnet berdasarkan pola indeks DST ditunjukkan pada Tabel 1. 

Tabel 1. Klasifikasi Indeks DST (INGV, 2015) 

Klasifikasi DST Intensitas DST (nT) 

Lemah -50 <  DST< -30 

Sedang -100 <  DST< -50 

Kuat -200 < DST < -100 

Sangat Kuat DST < - 200 

 

Medan magnet luar ini direduksi dengan koreksi variasi harian. Nilai variasi 

harian adalah nilai yang merepresentasikan gangguan terhadap medan magnet 

regional 𝐁𝟎 karena adanya sumber medan magnet luar. Untuk mendapatkan nilai 

variasi harian, digunakan persamaan (Gravmag, 2015): 

𝐵𝑉𝐻 =
(𝑡𝑛−𝑡𝑎)

(𝑡𝑏−𝑡𝑎)
(𝐵𝑏𝑎𝑠𝑒 𝑏 − 𝐵𝑏𝑎𝑠𝑒 𝑎) (9) 

Dengan 𝐵𝑉𝐻 adalah nilai variasi harian,  𝑡𝑛 adalah waktu saat pengukuran dalam 

detik, 𝑡𝑎 adalah waktu terukur di base awal dalam detik, 𝑡𝑏 adalah waktu terukur di 

base akhir dalam detik, 𝐵𝑏𝑎𝑠𝑒 𝑏 adalah nilai medan magnet total pada base akhir 

dalam nT, dan 𝐵𝑏𝑎𝑠𝑒 𝑎 adalah nilai medan magnet total pada base awal dalam nT.  

4. Anomali Medan Magnet 

Perubahan medan utama baik lokal maupun regional disebabkan oleh adanya 

variasi susunan mineral magnetis dari batuan-batuan dekat permukaan. Nilai medan 

magnet lokal maupun regional akibat adanya variasi susunan mineral magnetik dari 

batuan-batuan dekat permukaan ini disebut anomali medan magnet. Pada 
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pengukuran geomagnet, nilai inilah yang sejatinya dicari. Nilai anomali medan 

magnet diperoleh setelah dilakukan koreksi IGRF dan koreksi variasi harian. Oleh 

karena itu, nilai anomali medan magnet diperoleh dengan persamaan (Santoso, 

2002): 

∆𝐵 = 𝐵 − 𝐵𝐼𝐺𝑅𝐹 ∓ 𝐵𝑉𝐻 = 𝐵 − (𝐵𝐼𝐺𝑅𝐹 ± 𝐵𝑉𝐻)                                       (10) 

dengan 𝐵 adalah medan magnet hasil pengukuran di lapangan, 𝐵𝐼𝐺𝑅𝐹 adalah nilai 

IGRF yang mewakili nilai medan magnet utama bumi B0, dan 𝐵𝑉𝐻 adalah nilai 

variasi harian yang mewakili nilai medan magnet luar. Arah ∆𝐵 sama dengan arah 

𝐵. 

 

C. Kemagnetan Material Bumi 

1. Sifat-Sifat Kemagnetan Material Bumi 

Anomali medan magnet yang terukur di permukaan dipengaruhi oleh susunan 

mineral pada batuan di dekat permukaan. Hal ini disebabkan oleh adanya perbedaan 

karakteristik kemagnetan setiap material di bumi yang terutama dipengaruhi oleh 

nilai suseptibilitas material tersebut. Menurut Hinze et al. (2012), berdasarkan nilai 

suseptibilitasnya, sifat kemagnetan material-material di bumi dapat diklasifikasikan 

ke dalam 4 sifat yaitu: 

a. Diamagnet 

Material yang bersifat diamagnet merupakan material yang memiliki nomor 

atom genap dimana atom–atom pembentuk material tersebut mempunyai kulit atom 

berpasangan dan mempunyai spin yang saling berlawanan dalam tiap pasangan. 

Jika dikenai medan magnet dari luar, elektron-elektron tersebut akan menghasilkan 
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momen magnet yang berlawanan arah dengan medan magnet luar sehingga 

mempunyai suseptibilitas (k) negatif. 

b. Paramagnet 

Pada atom-atom dari material yang bersifat paramagnet terdapat elektron 

yang spinnya tidak berpasangan dan mengarah pada arah spin yang sama. Jika 

dikenai medan magnet luar, elektron-elektron tersebut akan menghasilkan momen 

magnet yang mengarah searah dengan medan tersebut sehingga memperkuat 

medan. Akan tetapi momen magnet yang terbentuk terorientasi acak sehingga 

material tersebut dapat dikatakan mempunyai suseptibilitas yang positif namun 

sangat kecil dimana 0 < k < 10-3 dalam satuan SI, namun pada umumnya dalam 

rentang nilai k dari 10-3 hingga 10-5 SI. 

c. Ferrimagnet 

Ferrimagnet terjadi karena adanya interaksi antara atom-atom yang 

berdekatan di mana momen magnet akan menuju ke arah medan magnet luar. 

Material ferrimagnet memiliki suseptibilitas dalam rentang 0 < k < 10-3 SI. Material 

ini merupakan sumber kemagnetan yang paling umum ditemukan sebagai penyebab 

anomali medan magnet di permukaan bumi. 

d. Ferromagnet 

Sifat ferromagnet pada material disebabkan oleh interaksi atom-atom yang 

bersebelahan dan membentuk kelompok-kelompok atom yang disebut domain. 

Domain-domain ini menyearahkan momen-momen magnet mereka paralel satu 

sama lain. Domain-domain tersebut memiliki dimensi 10-6 m dan akan 

mengembang ketika dikenai medan magnet dari luar. Selain itu pada atom-atom 
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material ferromagnet terdapat banyak kulit atom yang hanya diisi oleh satu elektron 

sehingga mudah terinduksi oleh medan luar. Suseptibilitas untuk material jenis ini 

selalu positif dan jauh lebih besar dari 1 (k  > 1). 

2. Kemagnetan Pada Batuan 

a. Kemagnetan Pada Batuan Beku 

Batuan beku terbentuk dari magma yang membeku. Magma berasal dari 

astenosfer yang meleleh akibat kenaikan suhu, penurunan tekanan, dan kenaikan 

kadar air. Magma tersebut dapat mengalami litifikasi di bawah permukaan maupun 

di atas permukaan. Magma mengandung sebagian besar oksigen dan silikon serta 

enam unsur lain yang umum ditemukan di kerak bumi, yaitu aluminium, besi, 

magnesium, kalsium, potassium, dan sodium. Variasi jumlah kandungan kedelapan 

unsur tersebut menyebabkan batuan beku hasil litifikasi magma memiliki susunan 

mineral yang berbeda-beda (Thompson & Turk, 1997). 

Kemagnetan pada batuan beku dapat dijelaskan berdasarkan klasifikasi 

batuan ini dilihat dari susunan mineralnya. Batuan beku basa memiliki jumlah 

kandungan besi dan titanium oksida lebih banyak daripada batuan beku asam 

(sekitar 5% untuk batuan beku basa dan 1% untuk batuan beku asam) sehingga 

batuan beku basa umumnya memiliki sifat kemagnetan yang lebih besar daripada 

batuan beku asam. Pada batuan intermediet, batuan ini memiliki kandungan mineral 

terutama silika di antara batuan beku asam dan batuan beku basa sehingga memiliki 

sifat kemagnetan di antara batuan beku asam dan batuan beku basa. Sedangkan 

batuan beku ultrabasa tentu memiliki sifat kemagnetan yang lebih besar dari batuan 

beku basa. Akan tetapi, kemagnetan pada batuan beku selain bergantung pada 
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komposisi mineral di dalam batuannya juga bergantung pada asal batuan beku 

tersebut, keadaan geologi sekitar, dan proses geokimia yang terjadi selama litifikasi 

(pembentukan batuan) sehingga sifat kemagnetan (suseptibilitas) yang dihasilkan 

akan sangat kompleks dan berbeda-beda di setiap tempat. 

Tabel 2. Suseptibilitas Batuan Beku (Telford et al., 2004).  

Nama Batuan Kisaran (× 𝟏𝟎−𝟑) Rata-Rata (× 𝟏𝟎−𝟑) 

Granit 0-50 2,5 

Riolit 0,2-35  

Dolorit 1-35 17 

Olivine-diabase  25 

Diabase 1-160 55 

Porfiri 0,3-200 60 

Gabbro 1-90 70 

Basalt 0,2-175 70 

Diorit 0,6-120 85 

Piroksenit  125 

Peridotit 90-200 150 

Andesit  160 

 

b. Kemagnetan Pada Batuan Sedimen 

Dari segi karakteristik, baik secara kimiawi maupun asal-usul batuan, batuan 

sedimen pada umumnya memiliki sifat kemagnetan yang jauh lebih kecil 

dibandingkan dengan batuan-batuan kristalin (batuan beku dan metamorf) karena 

kandungan mineral-mineral ferrimagnet pada batuan sedimen yang jauh lebih 

sedikit. Sebagian besar batuan sedimen klastik, yaitu batuan sedimen yang tersusun 

dari fragmen-fragmen endapan batuan lapuk (klastik) dan mengandung sangat 

sedikit mineral ferrimagnet sehingga nilai anomali medan magnet yang 

ditimbulkannya juga sangat kecil (Hinze et al., 2012). 
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Tabel 3. Suseptibilitas Batuan Sedimen (Telford et al., 2004).  

Nama Batuan Kisaran (× 𝟏𝟎−𝟑) Rata-Rata (× 𝟏𝟎−𝟑) 

Dolomit 0 - 0,9 0,1 

Batu Kapur 0-3 0,3 

Batu Pasir  0-20 0,4 

Serpih 0,01-15 0,6 

 

c. Kemagnetan Pada Batuan Metamorf 

Batuan metamorf adalah batuan yang kandungan mineral, tekstur, dan 

strukturnya berubah pada keadaan padat karena kenaikan suhu dan tekanan pada 

saat litifikasi sehingga sifat kemagnetannya sangat bervariasi. Jika batuan metamorf 

asalnya adalah batuan beku, biasanya sifat kemagnetannya berkurang selama proses 

metamorfisme (Haggerty dalam Hinze et al., 2012). Sedangkan efek metamorfisme 

pada batuan metamorf yang asalnya dari batuan sedimen pada umumnya sangat 

kecil (Hinze et al., 2012). 

Tabel 4. Suseptibilitas Batuan Metamorf (Telford et al., 2004).  

Nama Batuan Kisaran (× 𝟏𝟎−𝟑) Rata-Rata (× 𝟏𝟎−𝟑) 

Amfibolit  0,7 

Schist 0,3-3 1,4 

Phyllite  1,5 

Gneiss 0,1-25  

Kuarsit  4 

Serpentine 3-17  

Sabak 0-35 6 

 

3. Kemagnetan Pada Mineral 

Mineral adalah padatan non-organik yang terbentuk secara alami, memiliki 

karakteristik dari komposisi kimianya, dan berstruktur kristalin (Thompson & Turk, 

1997). Mineral merupakan bahan penyusun suatu batuan sehingga sifat magnet 
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pada batuan dipengaruhi oleh kandungan mineral pada batuan tersebut. Nilai 

suseptibilitas dari beberapa jenis mineral ditunjukkan ada Tabel 5. 

Tabel 5. Suseptibilitas Beberapa Jenis Mineral (Telford et al., 2004).  

Nama Mineral Kisaran (× 𝟏𝟎−𝟑) Rata-Rata (× 𝟏𝟎−𝟑) 

Grafit  0,1 

Kuarsa  -0,01 

Batu Garam  -0,01 

Anhidrit, Gypsum  -0,01 

Kalsit -0,001 - -0,01  

Batu Bara  0,02 

Mineral Lempung  0,2 

 

D. Transformasi 

1. Reduksi Ke Kutub 

Baranov dan Naudy dalam Blakely (1996) mengembangkan metode 

transformasi untuk menyederhanakan interpretasi data magnet pada daerah 

berlintang rendah dan menengah yang dikenal dengan reduksi ke kutub. Proses 

transformasi reduksi ke kutub dapat mengurangi satu tahap kompleks dari proses 

interpretasi, dimana anomali medan magnet menunjukkan langsung keberadaan 

target sumber yang dicari.  

Proses transformasi ini dilakukan dengan mengubah parameter medan 

magnet bumi pada daerah penelitian menjadi kondisi menyerupai di kutub yang 

memiliki deklinasi 0o dan inklinasi 90o  sehingga arah magnetisasi dan medan utama 

pada daerah penelitian berubah dalam arah vertikal. 
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Gambar 6. PerbandinganAnomali Medan Magnet Sebelum dan Sesudah Direduksi 

ke Kutub (Blakely, 1996). 

 

2. Kontinuasi Ke Atas 

Kontinuasi ke atas (upward continuation) adalah proses mentransformasi 

medan potensial terukur di atas permukaan menjadi medan yang terukur pada 

permukaan lain yang jauh dari sumber. Transformasi ini mengatenuasi anomali 

medan magnet dan bervariasi terhadap panjang gelombang, dimana semakin 

pendek gelombang semakin besar atenuasinya. Proses kontinuasi ke atas 

menurunkan nilai medan magnet terukur. Transformasi ini memiliki beberapa 

fungsi,  pertama untuk membandingkan atau menggabungkan hasil pengukuran 

yang dilakukan pada ketinggian yang berbeda, kedua untuk menonjolkan anomali 

medan magnet yang disebabkan oleh sumber anomali yang merupakan target 

penelitian dan letaknya dalam sedangkan di sekitarnya terdapat sumber anomali 

lain (yang bukan target penelitian) letaknya lebih dangkal.  

Konsep dasar dari transformasi ini berasal dari identitas ketiga Teorema 

Green. Teorema ini menjelaskan bahwa jika suatu fungsi 𝑈 adalah harmonik, 

kontinyu, dan mempunyai turunan yang kontinyu di sepanjang daerah 𝑅, maka nilai 

𝑈 pada suatu titik 𝑃 di dalam daerah 𝑅 (Gambar 7) dapat dinyatakan dengan 

persamaan (Blakely, 1996): 
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𝑈(𝑃) =
1

4𝜋
∫ (

1

𝑟

𝜕𝑈

𝜕𝑛
− 𝑈

𝜕

𝜕𝑛

1

𝑟
)

𝑆
𝑑𝑆 (11) 

dengan 𝑆 menunjukkan permukaan daerah 𝑅, 𝑛 menunjukkan arah normal keluar, 

dan 𝑟 adalah jarak dari titik 𝑃 ke suatu titik permukaan 𝑆. Persamaan 11 

menjelaskan prinsip dasar dari kontinuasi ke atas, bahwa suatu medan potensial 

dapat dihitung pada setiap titik di dalam suatu daerah berdasarkan sifat medan 

magnet pada permukaan yang melingkupi daerah tersebut. 

 
Gambar 7. Kontinuasi ke Atas dari Permukaan Horizontal (Blakely, 1996). 

 

 

E. Proton Precession Magnetometer 

Proton Precession Magnetometer (PPM) merupakan alat yang digunakan 

untuk mengukur medan magnet bumi. Alat ini terdiri dari tabung console, tabung 

sensor yang berisi kumparan dan cairan kaya proton (pada PPM yang digunakan 

dalam penelitian ini cairan yang digunakan adalah kerosene atau minyak tanah) 

dimana di belakang tabung terdapat kabel penghubung yang ketika pengukuran 

dilakukan dihubungkan ke tabung console, dan tongkat penyangga sensor. Di dalam 

tabung console secara umum terdapat baterai, rangkaian penghitung frekuensi 

(counter), dan amplifier.  
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Prinsip kerja PPM yaitu dengan mengukur frekuensi presesi proton. Hal ini 

didasarkan pada pengetahuan bahwa setiap atom adalah massa yang bermuatan 

listrik positif dan berputar. Putaran dari partikel bermuatan ini menghasilkan 

momen magnet dan momentum angular pada arah sumbu putarnya sehingga proton 

akan berpresesi, seperti ditunjukkan pada Gambar 8. Jumlah putaran  proton di 

sekitar sumbu dalam waktu tertentu inilah yang disebut frekuensi presesi proton 

(𝑓). Nilai 𝑓 tergantung pada momen magnet proton 𝑚, momentum angular proton 

𝐿, dan medan magnet bumi 𝐵 yang dapat dinyatakan dalam persamaan (Telford, et 

al., 2004): 

𝑓 =
𝑚

2𝜋𝐿
𝐵 =

𝐺𝐵

2𝜋
  (12) 

dengan konstanta 𝐺 =
𝑚

𝐿
 adalah rasio giromagnet dan faktor dari 

2𝜋

𝐺
= 23,487 ±

0,002 nT/Hz, maka persamaanya dapat dituliskan sebagai berikut: 

𝐵 = 23,487𝑓                                            (13) 

 
Gambar 8. Analogi Proton Precession dan Spinning-Top (Telford et al., 2004). 

 

Kabel penghubung antara sensor dan console berfungsi untuk 

menghubungkan kumparan di dalam sensor dengan rangkaian penghitung frekuensi 
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yang berada di dalam console. Ketika sensor dan console belum dihubungkan yang 

artinya tidak ada arus yang melalui kumparan, maka tidak ada medan magnet di 

sekitar kumparan sehingga proton-proton di dalam sensor mempolarisasikan diri ke 

arah medan magnet bumi. Ketika sensor dan console dihubungkan yang artinya arus 

listrik dilewatkan melalui kumparan tersebut, maka akan timbul medan magnet dan 

mempolarisasikan proton pada arah kumparan. Pada saat arus diputus, yaitu saat 

pengguna menekan tombol READ pada console, kumparan akan dihubungkan 

dengan rangkaian penghitung frekuensi, sementara proton akan berpresesi pada 

arah medan magnet bumi. Gerakan momen magnet proton akan menghasilkan 

medan magnet siklik yang menginduksi arus pada kumparan dengan interval 3 detik 

sebelum proton berhenti berpresesi. Selama interval waktu tersebut, penghitung 

frekuensi akan mengukur frekuensi presesi proton. Nilai frekuensi presesi proton 

yang terukur kemudian diolah dan nilai medan magnet total ditampilkan pada layar 

PPM (Telford et al., 2004). 

 

Gambar 9. (a) Rangkaian Komponen PPM (b) Keadaan Proton di Dalam Sensor 

Ketika Pengukuran (Hinze et al., 2012). 
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F. Panas Bumi 

1. Energi dan Sistem Panas Bumi 

Menurut Suparno (2009),energi panas bumi adalah energi panas alami dari 

dalam bumi yang ditransfer ke permukaan bumi secara konduksi dan konveksi. 

Secara umum perubahan kenaikan suhu terhadap kedalaman di kerak bumi adalah 

sekitar 30°C/km. Dari sudut pandang geologi, sumber energi panas bumi berasal 

dari magma yang berada di dalam bumi. Ia berperan seperti kompor yang menyala. 

Magma tersebut menghantarkan panas secara konduktif pada batuan disekitarnya. 

Panas tersebut juga mengakibatkan aliran konveksi fluida hidrotermal di dalam 

pori-pori batuan. Fluida di dalam pori-pori batuan ini biasanya berupa air meteorik 

dari permukaan yang masuk ke bawah permukaan melalui daerah resapan. 

Kemudian fluida hidrotermal ini akan bergerak ke atas namun tidak sampai ke 

permukaan karena tertahan oleh lapisan batuan yang bersifat impermeabel. Lokasi 

tempat terakumulasinya fluida hidrotermal disebut reservoir, atau lebih tepatnya 

reservoir panas bumi. Dengan adanya lapisan impermeabel tersebut, maka 

hidrotermal yang terdapat pada reservoir panasbumi terpisah dengan air tanah yang 

berada lebih dangkal. Berdasarkan itu semua maka secara umum sistem panas bumi 

terdiri atas empat elemen: 

a. daerah resapan untuk menangkap air hujan (air meteorik), 

b. batuan reservoir,  

c. fluida reservoir, yang berperan menghantarkan panas ke permukaan tanah, 

d. batuan panas (heat rock) atau magma sebagai sumber panas.  
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Menurut Lawless dalam Saptadji (2009), sumber panas adalah intrusi batuan 

beku, diperkirakan terdapat pada kedalaman 2 – 5 km. Komposisi intrusi bisa 

berupa batuan granit atau gabro, tapi yang umum adalah diorit. Host rocks (batuan 

asal) umumnya batuan beku vulkanik. 

 

2. Model Geologi Sistem Panas Bumi 

Kondisi geologi sumber-sumber panas bumi dunia sangat beragam. 

Pengelompokan geologi daerah panas bumi dapat dibagi menjadi dua kelompok 

besar yaitu sistem magmatik vulkanik aktif dan sistem selain magmatik vulkanik 

aktif. Sebagian besar sistem magmatik aktif memiliki temperatur yang tinggi (lebih 

dari 180°C) dan bisa dimanfaatkan untuk pembangkit listrik. Pemanfaatan energi 

panas bumi secara langsung (direct use) bisa diperoleh dari kedua sistem (Marini, 

2001).  

Sistem magmatik vulkanik aktif yang bertemperatur tinggi umumnya terdapat 

di sekitar pertemuan lempeng samudera dan lempeng benua. Posisi Indonesia 

berada di batas antara lempeng Eurasia dan Indo-Australia sehingga Indonesia 

memiliki potensi panas bumi yang cukup tinggi (Suparno, 2009).  

Gambar 10 merupakan penampang vertikal geologi daerah vulkanik aktif 

akibat tumbukan antara lempeng samudera (oceanic crust) dan lempeng benua 

(continental crust) dimana lempeng samudera menunjam ke bawah lempeng benua. 

Temperatur yang sangat tinggi pada kerak bumi menyebabkan lempeng samudera 

meleleh. Lokasi lelehan (zone of partial melting) diperkirakan berada pada 

kedalaman 100 km dari permukaan bumi di antara kerak bumi dan bagian luar 

mantel bumi. Massa jenis lelehan akan lebih rendah dari sumbernya sehingga 
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lelehan tersebut akan cenderung naik ke atas dan menjadi magma. Magma tidak 

pernah ditemukan dalam bentuk cair murni. Semua magma adalah lelehan batuan 

panas dengan campuran antara silikat cair, kristal mineral, gas karbondioksida serta 

senyawa beracun lainnya yang membentuk campuran kompleks. Magma saat 

mendekati permukaan bumi akan menyebabkan letusan vulkanik. Magma yang 

sudah keluar ke permukaan bumi disebut lava yang berupa lelehan batuan panas 

yang akan menjadi dingin secara perlahan dan membentuk batuan beku vulkanik di 

permukaan tanah. Magma yang bergerak ke atas pun bisa terjebak di dalam bumi 

dan perlahan-lahan menjadi dingin membentuk batuan beku sehingga komposisi 

magma dapat ditentukan dari komposisi batuan beku. Proses vulkanik melibatkan 

unsur-unsur gas yang terkadung dalam magma sehingga mengakibatkan komposisi 

batuan beku tidak selalu sama dengan komposisi magma aslinya (Suparno, 2009). 

 
Gambar 10. Peta Sebaran Daerah Vulkanik Aktif di Indonesiadan Zona Tumbukan   

Lempeng Benua Eurasia dan Indo-Australia (Hochstein & Sudarman 

dalam Suparno, 2009). 
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3. Manifestasi Panas Bumi 

Menurut BSNI (1998) manifestasi panas bumi adalah gejala di permukaan 

yang merupakan ciri terdapatnya potensi energi panas bumi di bawah permukaan 

daerah tersebut. Beberapa jenis manifestasi panas bumi adalah sebagai berikut: 

1. Tanah Hangat (Warm Ground)  

Tanah hangat merupakan salah satu manifestasi panas bumi yang ditandai 

dengan adanya tanah yang memiliki temperatur lebih tinggi dari pada temperatur 

tanah di sekitarnya. Hal ini disebabkan karena adanya perpindahan panas secara 

konduksi dari batuan bawah permukaan ke batuan permukaan.  

2. Tanah Beruap (Steaming Ground)  

Tanah beruap ditandai dengan adanya uap panas (steam) yang keluar dari 

dalam tanah. Uap panas ini berasal dari suatu lapisan tipis dekat permukaan yang 

mengandung air panas yang mempunyai temperatur yang sama atau lebih besar dari 

titik didihnya.  

3. Mata Air Panas (Hot Spring) 

Mata air panas terbentuk akibat adanya aliran panas dari bawah permukaan 

melalui rekahan-rekahan batuan. 

4. Fumarole 

Fumarole adalah lubang kecil yang memancarkan uap panas kering (dry 

steam) atau uap panas yang mengandung air (wet steam). Apabila uap tersebut 

mengandung H2S maka manifestasi permukaan disebut solfatara.  
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5. Geyser  

Geyser adalah mata air panas yang menyembur ke udara secara intermitten 

(pada selang waktu tak tentu) dengan ketinggian tertentu. 

6. Kubangan Lumpur Panas (Mud Pools)  

Kubangan lumpur panas umumnya mengandung CO2 dengan sejumlah kecil 

uap panas. Lumpur terdapat dalam keadaan cair karena kondensasi uap panas, 

sedangkan letupan terjadi karena pancaran CO2. 

7. Sinter Silika  

Sinter silika merupakan endapan silika di permukaan yang memiliki warna 

keperakan. Sinter silika umumnya dijumpai di sekitar mata air panas dan lubang 

geyser.  

8. Batuan Teralterasi  

Alterasi hidrotermal adalah proses yang terjadi karena adanya reaksi antara 

batuan dengan fluida panas bumi (mengandung klorida) yang berasal dari reservoir 

panas bumi yang terdapat di bawah permukaan. Hal tersebut menyebabkan 

terjadinya pengendapan dan pertukaran elemen-elemen batuan dengan fluida.  

4. Sifat Batuan Panas Bumi 

Sebagian besar reservoir panas bumi terdapat pada batuan vulkanik dengan 

aliran utama melalui rekahan. Seperti halnya di perminyakan, parameter yang 

dalam penting menerangkan sifat batuan reservoir panas bumi adalah porositas, 

permeabilitas, densitas, dan konduktivitas termal batuan (Saptadji, 2002). 

Reservoir panas bumi umumnya ditemukan pada batuan rekah alami, di mana 

batuannya terdiri dari rekahan-rekahan dan pori-pori. Volume pori-pori batuan 
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tersebut umumnya dinyatakan sebagai fraksi dari volume total batuan dan 

didefinisikan sebagai porositas batuan.  

Permeabilitas batuan adalah ukuran kemampuan batuan untuk mengalirkan 

fluida. Permeabilitas batuan merupakan parameter yang penting untuk menentukan 

kecepatan aliran fluida di dalam batuan berpori dan batuan rekah alami. Besarnya 

permeabilitas batuan tidak sama ke segala arah (anisotropi), umumnya 

permeabilitas pada arah horizontal jauh lebih besar dari permeabilitas pada arah 

vertikal (Saptadji, 2002). 

Densitas batuan adalah perbandingan antara berat batuan dengan volume 

batuan tersebut (Saptadji, 2002). Pada umumnya batuan yang letaknya lebih dalam 

akan memiliki densitas batuan yang lebih besar. 

Konduktivitas termal suatu batuan merupakan parameter yang menyatakan 

besarnya kemampuan batuan tersebut untuk menghantarkan panas dengan cara 

konduksi apabila pada batuan tersebut terdapat perbedaan temperatur (gradien 

temperatur) (Saptadji, 2002). 

 

G. Sesar 

Sesar adalah retakan pada batuan dimana salah satu sisi dari batuan tersebut 

bergerak relatif terhadap sisi yang lain. Jarak pergerakan salah satu sisi batuan 

terhadap sisi yang lain disebut slip. Kedua sisi batuan yang terpisah akibat adanya 

retakan ini dapat bergerak relatif vertikal dengan kemiringan tertentu maupun 

bergerak horizontal. Pada sesar yang kedua sisinya bergerak vertikal dengan 

kemiringan tertentu dikenal istilah hanging wall dan foot wall. Istilah-istilah 
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tersebut diperkenalkan oleh para penambang dimana sisi batuan yang bergantung 

di atas kepala mereka disebut hanging wall dan sisi lain dimana mereka 

menapakkan kaki disebut foot wall (Thompson & Turk, 1997).  

Dalam topografi, ciri sesar dapat dilihat dari adanya suatu pemisahan pada 

suatu bentuk kontinyu, adanya lapisan yang hilang, atau adanya pergeseran secara 

vertikal yang menyebabkan adanya perpindahan. Kondisi tersebut biasanya 

ditandai dengan adanya pembelokan sungai secara tiba-tiba dan terputusnya 

kesinambungan pada bentuk geologi seperti bentang alam. Berdasarkan pergerakan 

sisi-sisi batuannya, sesar dikelompokkan menjadi tiga jenis, yaitu: 

1. Sesar Turun (Normal Fault) 

Sesar turun adalah sesar yang hanging wallnya bergerak relatif turun terhadap 

foot wallnya. Ilustrasi sesar turun ditunjukkan pada Gambar 11. 

 
Gambar 11. Ilustrasi Sesar Turun (Thompson & Turk, 1997). 

 

 

 

2. Sesar Naik (Reverse Fault) 

Sesar naik adalah sesar yang hanging wallnya bergerak relatif naik terhadap 

foot wallnya. Ilustrasi sesar naik ditunjukkan pada Gambar 12. 
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Gambar 12. Ilustrasi Sesar Naik (Thompson & Turk, 1997). 

 

 

3. Sesar Mendatar (Strike-Slip Fault) 

Sesar mendatar adalah sesar yang retakan batuannya vertikal atau mendekati 

vertikal dan kedua sisinya saling bergerak horizontal. Ilustrasi sesar mendatar 

ditunjukkan pada Gambar 13. 

 
Gambar 13. Ilustrasi Sesar Mendatar (USGS, 2017). 

 

 

H. Tinjauan Geologi  

1. Pembagian Umur Geologi 

Para ahli geologi membagi waktu geologi menjadi satuan-satuan yang lebih 

kecil serta memberi nama pada tiap-tiap satuan tersebut. Hal ini dilakukan untuk 

mempermudah analisis data terutama dalam memperkirakan umur batuan karena 

skala waktu dalam geologi tidak diketahui secara pasti. Pembagian waktu geologi 

secara resmi ditetapkan oleh International Union of Geological Sciences (IUGS). 

Tabel pembagian waktu geologi ditunjukkan pada Tabel 6. 
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Tabel 6. Pembagian Waktu Geologi (Thompson & Turk, 1997). 

KURUN MASA ZAMAN KALA 

JANGKA 

WAKTU 

( 106 tahun yang 

lalu) 

F
an

er
o
zo

ik
 

S
en

o
zo

ik
 

Kuarter 
Holosen ? - Sekarang 

Pleistosen 2 - ? 

T
er

si
er

 Neogen 
Pliosen 5 – 2 

Miosen 24 – 5 

Paleogen 

Oligosen 37 – 24 

Eosen 58 – 37 

Paleosen 66 – 58 

M
es

o
zo

ik
 

Kapur 

 

144 - 66 

Jurasik 208 - 144 

Triasik 245 – 208 

P
al

eo
zo

ik
 

Permian 286 – 245 

K
ar

b
o
n
if

er
an

 

Pennsylvanian 320 – 286 

Mississippian 360 – 320 

Devonian 408 – 360 

Silurian 438 – 408 

Ordovisian 505 – 438 

Kambrian 538 – 505 

Proterozoik Ketiga kurun tersebut sering 

dianggap sama dan disebut 

“Prekambrian” 

2500 – 538 

Archean 3800 – 2500 

Hadean 4600- 3800 

 

2. Geologi Daerah Penelitian 

Di daerah manifestasi panas bumi Tinatar terdapat dua sumber mata air panas. 

Mata air panas pertama di manifestasi panas bumi Tinatar muncul melalui retakan-

retakan lava di tepi barat Sungai Pacitan. Suhu permukaan air panas 39°C dan debit 

0,3 liter/detik. Mata air panas kedua berlokasi sekitar 200 meter sebelah barat tebing 

Sungai Pacitan muncul pada tubuh tanah di persawahan penduduk dengan suhu 

permukaan 40°C dan debit 3 liter/detik.  
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Lokasi sumber mata air panas Karangreo terletak di dekat pemukiman 

Bladeras, Desa Karangrejo. Suhu air panas mencapai 52°C, besar debit sekitar  3 

liter/detik dengan pH 7, muncul daerah gawir sesar di bagian barat lembah Sungai 

Brungkah. Di sekitar sumber air panas tidak tampak pengaruh batuan hidrotermal 

terhadap batuan tufa breksi. Batu tufa breksi ini sangat terpadu dan sebagian besar 

kepingan rombakan batuan gunung api (andesit-dasitan) tersemen tufa. Breksi tufa 

berumur tersier dan berada selaras di bawah tufa dan di atas endapan sedimen 

klastik yang dinyatakan sebagai breksi (Iryanto dalam Akbar et al., 1993).  

Sekitar manifestasi panas bumi Tinatar dan Karangrejo hanya terdapat 

pengubahan batuan gunung api tua oleh pengaruh hidrotermal. Suhu tubuh tanah di 

daerah ubahan tidak memperlihatkan perbedaan dengan suhu udara di sekitarnya. 

Ubahan batuan tersebut hanya merupakan fosil stadium hidrotermal, besar 

kemungkinan berkaitan dengan mineralisasi yang berlangsung pada batuan gunung 

api tersier di daerah lainnya. 

Kemunculan mata air panas Tinatar dan Karangrejo di Kabupaten Pacitan 

merupakan kenampakan gejala-gejala panas bumi pada Pegunungan Selatan di 

Jawa Timur dimana Pegunungan Selatan pada umumnya didominasi oleh sebaran 

batuan tersier.  

Kelompok batuan tersier di daerah manifestasi panas bumi Tinatar dan 

Karangrejo terdiri dari batuan gunung api tua yaitu lava dan breksi tufa. Di sekitar 

manifestasi panas bumi Tinatar, tersingkap breksi tufa dan lava yang bertindak 

sebagai batuan dasar setempat. Sebagian besar lava sangat terkekarkan. Di sekitar 

manifestasi panas bumi tersebut juga terlihat aluminium sulfat yang serupa pada 
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celah-celah lava di sekitarnya. Penyebaran lava breksi dan tufa ini ditutupi oleh 

endapan sedimen klastik halus tufa dan sedimen klastik kasar berupa breksi yang 

memiliki beraneka ragam fragmen (Akbar et al., 1993). 

Penyebaran batuan serupa juga dijumpai di sekitar manifestasi panas bumi 

Karangrejo dimana masa dasar breksi tufa memperlihatkan kompaksi (kepadatan) 

yang sangat baik. Batuan intrusi juga terlihat pada daerah ini berupa batuan dasit. 

Intrusi dasit merupakan akhir kegiatan vulkanisme di Pegunungan Selatan dan 

sebagian besar berkaitan dengan pembentukan mineralisasi oleh pengaruh kegiatan 

hidrotermal yang berkaitan dengan kontak intrusi dasit tadi. Intrusi batuan ini 

diperkirakan terjadi pada kala miosen tengah (Van Bemmelen, 1949). 

Pelataran bentang alam daerah penyebaran batuan tersier sebagian besar 

sebagai penorehan struktur sesar. Diperkirakan melalui Sungai Pacitan dan Sungai 

Brungkah, terdapat sesar yang berarah hampir barat laut-tenggara. Besar 

kemungkinan jenis kedua sesar adalah sesar geser mendatar dengan gerakan 

menganan. Struktur sesar ini perkembangannya dari pola struktur sesar lebih tua 

pada pegunungan selatan (Akbar et al., 1993). 

 

3. Stratigrafi Daerah Penelitian 

Pada daerah penelitian terdapat beberapa formasi, yaitu Formasi Arjosari, 

Formasi Mandalika, Formasi Jaten, Formasi Aluvial, dan batuan terobosan 

(intrusif). Formasi-formasi batuan yang berada di daerah penelitian umumnya 

berzaman tersier dengan kode berawalan huruf T seperti Toma, Tomm, Tomi, dan 

Tmj, hingga kuarter dengan kode berawalan huruf Q, yaitu Qa (Formasi Aluvial). 
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Formasi batuan tertua di daerah penelitian adalah hasil endapan arus gravitasi, 

yang dicirikan oleh batuan vulkanoklastik dan dikelompokkan sebagai Formasi 

Arjosari, berumur oligosen akhir hingga miosen awal dan mempunyai ketebalan 

±500 m. Litologinya terdiri dari breksi polimik sisipan tufa dan batu pasir tufaan 

pada bagian bawah. Pada bagian tengah, terdiri dari breksi polimik, batu pasir, lava 

andesit, tufa dengan sisipan batu lempung. Sedangkan pada bagian atas terdiri dari 

batu pasir konglomeratan, perselingan breksi vulkanik, lava dan tufa. 

Secara menjari diendapkan perulangan satuan breksi vulkanik, lava bantal, 

tufa, tufa dasitik, dan batu pasir tufaan yang diendapkan pada lingkungan laut 

dangkal dan dikelompokan sebagai Formasi Mandalika, berumur oligosen akhir 

hingga miosen awal dan mempunyai ketebalan ± 300 m.  

Terobosan batuan beku pada Formasi Arjosari dan Formasi Mandalika terdiri 

dari dasit, andesit, andesit-basalt dan diorit. Terobosan tersebut berbentuk stock dan 

retas-retas yang memberikan kenampakan seperti “Volcanic Neck” dan 

diperkirakan berumur miosen tengah hingga miosen akhir. 

Pengendapan selanjutnya merupakan batuan sedimen klastik darat hingga 

laut dangkal. Satuan batuan ini terdiri dari batu pasir tufaan, konglomerat, batu pasir 

kuarsa, batu lempung, dan sisipan lignit yang dikelompokkan sebagai Formasi 

Jaten, berumur miosen awal - miosen tengah dan mempunyai ketebalan ± 150 m. 

Terakhir endapan aluvial membentuk satu formasi terdapat di sungai 

Grindulu bagian tengah sampai hilir, yaitu berupa material lepas dari hasil 

rombakan dan pelapukan batuan yang berumur lebih tua, terdiri dari kerakal, 

kerikil, pasir dan tanah (Abdullah et al., 2003). 
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Gambar 14. Kolom Stratigrafi daerah penelitian (Samodra et al., 1990). 

 

 

 

 

 



 

57 
 

BAB III 

METODE PENELITIAN 

 

A.  Waktu dan Tempat Penelitian 

Kegiatan pengambilan data geomagnet ini dilakukan dengan mengukur besar 

medan magnet total di titik-titik penelitian. Pengambilan data secara langsung 

dilaksanakan pada tanggal 21-23 Agustus 2017 di daerah manifestasi panas bumi 

Tinatar-Karangrejo dan sekitarnya yang mencakup 3 kecamatan di Kabupaten 

Pacitan, yaitu Kecamatan Punung, Kecamatan Pringkuku, dan Kecamatan Arjosari 

dengan batas wilayah penelitian 8°4’53,1’’ hingga 8°8’4,6’’ LS dan 111°4’10,7’’ 

hingga 111°8’32,1’’ BT seperti ditunjukkan pada Gambar 18. Titik penelitian 

berjumlah 31 titik dengan jarak antar titik ±1 km serta tambahan data sekunder 

sebanyak 23 titik penelitian. 

 
Gambar 15. Daerah Penelitian 
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B. Instrumen Penelitian 

Instrumen yang digunakan dalam penelitian ini terdiri dari perangkat lunak 

dan perangkat keras. Berikut adalah perangkat lunak dan perangkat keras yang 

digunakan: 

1. Perangkat Keras 

Peralatan yang digunakan dalam penelitian ini adalah:  

a. Satu set Proton Precession Magnetometer (PPM) merk Geometrics jenis G-856 

milik BMKG Yogyakarta yang ditunjukkan pada Gambar 16, terdiri dari: (a) 

sensor untuk mengukur besar medan magnet total; (b) Instrument console untuk 

membaca keluaran atau nilai medan magnet total dalam satuan nT, (c) kabel 

untuk menghubungkan sensor dengan instrument console, (d) tongkat untuk 

menyangga sensor saat pengukuran. 

 

Gambar 16. Seperangkat Alat PPM 

 



 

59 
 

b. Global Positioning System (GPS) merk Garmin jenis Map 78s (Gambar 17) 

untuk mengetahui koordinat titik pengukuran.  

 
Gambar 17. Global Positioning System Merk Garmin Jenis Map 78s 

 

c. Kompas geologi (Gambar 18) untuk mengetahui arah utara atau north (N) bumi 

saat pengambilan data dan untuk mengukur besar strike dan dip pada struktur 

singkapan batuan saat survei geologi lapangan. 

 
Gambar 18. Kompas Geologi 
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d. Palu geologi (Gambar 19) untuk mengambil sampel batuan saat survei geologi 

lapangan. 

 

 
Gambar 19. Palu Geologi 

 

 

e. Meteran dengan panjang 500 meter (Gambar 20) untuk mengukur panjang 

struktur singkapan batuan saat survei geologi lapangan. 

 

 
Gambar 20. Meteran dengan Panjang 500 meter 
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f. Lembar pencatatan data pengukuran dan kondisi lingkungan.  

 

 

2. Perangkat Lunak 

Perangkat lunak atau software yang digunakan dalam penelitian ini adalah: 

a. Surfer 12 untuk membuat desain survei dan model kontur data penelitian serta 

sebagai converter koordinat geografis longitude-latitude menjadi UTM atau 

sebaliknya. 

b. Global Mapper13 untuk meregister peta geologi yang akan digunakan untuk 

membuat desain survei. 

c. Oasis Montaj untuk mengolah data pada tahap reduksi ke kutub, kontinuasi ke 

atas, dan pemodelan 2D. 

d. Magblox untuk memasukkan data geologi daerah penelitian sebelum diolah 

menjadi model 3D. 

e. Bloxer unuk mengedit pemodelan 3D dan mengubah format pemodelan dari 

layer-layer agar dapat diolah oleh software Rockwork.  

f. Rockwork  untuk melakukan pemodelan 3D. 

g. Microsoft Office 2007 untuk mengolah dan menyusun data serta publikasi.  

 

C.  Tahapan Penelitian 

Penelitian yang dilakukan memiliki tahapan yang ditunjukkan oleh diagram 

alir pada Gambar 21. 
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Gambar 21. Tahapan Penelitian 

 

 

D. Akuisisi Data Medan Magnet 

Pengambilan data geomagnet diawali dengan kalibrasi alat. Kalibrasi 

dilakukan dengan melakukan proses tuning atau memilih kuat sinyal (signal 

strength) yang sesuai dengan harga medan magnet di kawasan penelitian yaitu 
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sekitar 45.000 nT serta mengatur waktu pada PPM sesuai dengan jam setempat dan 

memasukkan hari dimulainya penelitian dalam Julian Day.  

Terdapat dua cara pengukuran dalam penelitian metode geomagnet, yaitu 

metode base and rover dan metode looping. Pada metode base and rover digunakan 

dua buah PPM dimana satu PPM digunakan untuk mengukur nilai medan magnet 

total di satu titik tetap yang disebut base dan satu PPM untuk mengukur medan 

magnet di titik-titik penelitian yang disebut rover. Dari pengukuran di base 

diperoleh variasi nilai medan magnet total terhadap fungsi waktu yang kemudian 

disebut nilai variasi harian dan digunakan untuk mengoreksi nilai medan magnet 

dari hasil pengukuran di rover. Pada metode looping hanya digunakan satu PPM 

saja yang digunakan untuk mengukur medan magnet di base dan sebagai rover. 

Pengukuran yang dilakukan dalam penelitian ini menggunakan metode looping 

dimana dalam satu hari dilakukan pengukuran di base sebanyak 5 kali yaitu di pagi 

hari sekitar pukul 07.00, menjelang siang hari antara pukul 09.00-10.00, tengah hari 

antara pukul 12.00-13.00, menjelang sore antara pukul 14.00-15.00, dan sore hari 

sekitar pukul 17.00. 

Pengambilan data medan magnet di setiap titik diawali dengan mengeset 

serangkaian alat PPM. Kemudian indikator N (north) pada sensor diarahkan ke arah 

utara bumi dengan menggunakan kompas. Setelah itu nilai medan magnet terbaca 

pada instrument console. Pengukuran di setiap titik dilakukan sebanyak 5 kali. 
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E. Pengolahan Data 

Tahapan pengolahan data dalam penelitian ini ditunjukkan oleh diagram alir 

pada Gambar 22. 

 
Gambar 22. Diagram Alir Tahapan Pengolahan Data 

 

 

 

1. Koreksi Variasi Harian dan Koreksi IGRF 

Koreksi variasi harian dan koreksi IGRF merupakan dua koreksi utama untuk 

memperoleh anomali medan magnet. Nilai variasi harian (BVH) diperoleh dari 

persamaan 9. Setelah dilakukan koreksi variasi harian, selanjutnya dilakukan 

koreksi IGRF. Nilai IGRF dari titik-titik penelitian diperoleh dari web NOAA 
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(ngdc.noaa.gov) seperti ditunjukkan pada Gambar 23. Setelah dilakukan kedua 

koreksi tersebut, maka dapat diperoleh nilai anomali medan magnet yang 

sesungguhnya dari persamaan 10. 

 
Gambar 23. Koreksi IGRF dari web NOAA 

 

2. Reduksi ke Kutub 

Reduksi ke kutub adalah tahapan pengolahan data geomagnet yang berfungsi 

untuk menghilangkan pengaruh sudut inklinasi dan deklinasi magnet. Proses 

transformasi ini dilakukan dengan mengubah parameter medan magnet bumi pada 

daerah penelitian menjadi kondisi menyerupai di kutub yang memiliki deklinasi 0o 

dan inklinasi 90o  sehingga arah magnetisasi dan medan utama pada daerah 

penelitian berubah dalam arah vertikal. 

3. Kontinuasi ke Atas 

.Kontinuasi ke atas adalah tahapan dalam pengolahan data geomagnet yang  

dilakukan untuk menghilangkan pengaruh lokal yang berasal dari sumber-sumber 
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di permukaan. Proses ini mentransformasi anomali medan magnet terukur di atas 

permukaan menjadi anomali medan magnet yang terukur pada ketinggian tertentu. 

Penentuan ketinggian yang digunakan dalam penelitian ini dilakukan dengan cara 

trial and errors dengan melihat kecenderungan pola kontur yang terbentuk dari 

hasil kontinuasi. Kontinuasi ke atas dilakukan dengan software OASIS Montaj 

6.4.2. 

4. Pemodelan 2D  

Pemodelan 2D dilakukan setelah diperoleh kontur anomali medan magnet 

yang telah dikontinuasi ke atas. Pemodelan ini dilakukan untuk memprediksi 

susunan struktur batuan bawah permukaan secara 2D. Pemodelan dilakukan dengan 

software OASIS Montaj 6.4.2. Data yang digunakan sebagai dasar pembuatan 

model 2D adalah plot anomali medan magnet yang sudah dikontinuasi ke atas pada 

ketinggian 1200 m dengan mempertimbangkan keteraturan bentuk kontur yang 

terbentuk ketika trial and errors. Sebelum dilakukan pemodelan, data anomali 

medan magnet disayat sesuai dengan target penelitian. Proses penyayatan dilakukan 

untuk mendapatkan sampel nilai anomali medan magnet yang akan dimodelkan. 

Pada penelitian ini dibuat model 2D dengan lima sayatan yang disesuaikan dengan 

target penelitian dan informasi geologi di sekitarnya. 

5. Verifikasi Data Geologi 

Kegiatan verifikasi data geologi ini dilakukan untuk mengetahui jenis-jenis 

batuan yang ada di daerah penelitian sehingga dapat memperkuat pemodelan 

susunan struktur batuan. Kegiatan ini dilakukan dengan mendatangi titik-titik yang 

telah ditentukan yaitu terutama titik-titik pada sayatan 2D yang masih kurang 
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informasi geologinya, kemudian mengambil sampel batuan yang dominan di titik-

titik tersebut sekaligus mencari keberadaan singkapan, perlapisan, ataupun struktur 

batuan. Jika ditemukan struktur batuan, maka akan diukur panjang struktur, strike, 

serta dipnya 

6. Pemodelan 3D 

Pemodelan 3D dilakukan setelah pemodelan 2D selesai. Hal ini dikarenakan 

nilai suseptibilitas yang akan dimasukkan saat pemodelan 3D disesuaikan dengan 

suseptibilitas dari model 2D. Pada pemodelan 3D yang digunakan sebagai kontur 

awal yang akan disayat adalah kontur anomali medan magnet hasil reduksi ke 

kutub. Software-software yang digunakan dalam pemodelan 3D ini adalah software 

Rockwork, Magblox, dan Bloxer. Sebelum pemodelan dengan software Rockwork, 

data anomali medan magnet dianalisis dengan menggunakan software Magblox, 

dan Bloxer. Software Magblox digunakan untuk memasukkan informasi geologi 

seperti koordinat lokasi (koordinat x dan y dalam kilometer), jarak antar titik 

pengukuran, nilai dugaan kedalaman batuan dan nilai IGRF rata-rata. Setelah 

memasukkan data yang diperlukan, maka software Magblox akan mengolah data 

tersebut menjadi model dalam bentuk layer-layer. Setelah itu, data dalam layer 

dapat diedit lagi dengan software Bloxer menyesuaikan dengan model 2D. Software 

Bloxer juga mengubah format keluaran software Magblox agar dapat diolah oleh 

software Rockwork. Tahapan terakhir adalah pemodelan 3D dilakukan dengan 

software Rockwork. Seluruh informasi data geologi dari proses analisa akan 

diproses menjadi sebuah model 3D berdasarkan nilai suseptibilitas. 
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BAB IV 

HASIL DAN PEMBAHASAN 

 

Manifestasi panas bumi adalah gejala di permukaan yang merupakan ciri 

terdapatnya potensi energi panas bumi di bawah permukaan daerah tersebut. 

Manifestasi panas bumi ini dapat berupa tanah hangat, tanah beruap, sumber mata 

air panas, maupun fumarole. Di Indonesia sendiri manifestasi panas bumi 

kebanyakan berupa sumber mata air panas. Salah satu daerah di Indonesia yang 

memiliki manifestasi panas bumi adalah Kabupaten Pacitan. Terdapat dua 

manifestasi panas bumi berupa mata air panas di Kabupaten Pacitan yaitu 

manifestasi panas bumi di Desa Tinatar Kecamatan Punung dan manifestasi panas 

bumi di Desa Karangrejo Kecamatan Arjosari. Kedua mata air panas ini diketahui 

memiliki sumber panas yang sama sehingga dalam penelitian ini disebut sebagai 

manifestasi panas bumi Tinatar-Karangrejo. Manifestasi panas bumi Tinatar-

Karangrejo dikontrol oleh keberadaan sesar di dekatnya yaitu Sesar Tinatar dan 

Sesar Grinjing. Penelitian ini bertujuan untuk mengetahui pola sebaran anomali 

medan magnet, mengidentifikasi litologi bawah permukaan, serta mengidentifikasi 

pengaruh keberadaan Sesar Tinatar dan Sesar Grinjing terhadap kemunculan 

sumber mata air panas. 

Data yang diperoleh dari hasil akuisisi data lapangan berupa medan magnet 

total. Data medan magnet total ini kemudian dikoreksi menggunakan koreksi IGRF 

dan koreksi variasi harian sehingga diperoleh data berupa anomali medan magnet 

pada daerah penelitian. Pengolahan data ini dilakukan karena data medan magnet 
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total hasil akuisisi data lapangan masih dipengaruhi oleh medan magnet utama bumi 

dan medan magnet luar. Medan magnet luar dikoreksi dengan koreksi variasi 

harian, dan medan magnet utama bumi dikoreksi dengan koreksi IGRF. Anomali 

medan magnet yang telah dikoreksi variasi harian dan koreksi IGRF masih 

dipengaruhi medan magnet regional dan medan magnet lokal, sehingga untuk 

mengetahui medan magnet regional di kawasan penelitian, perlu dilakukan 

pemisahan dengan reduksi ke kutub dan kontinuasi ke atas.   

 

A. Medan Magnet Total 

Nilai medan magnet total hasil pengukuran memiliki rentang nilai 44.350 nT 

hingga 45.250 nT. Untuk mengetahui pola sebaran medan magnet total dilakukan 

proses interpolasi sehingga membentuk kontur medan magnet total yang 

ditunjukkan pada Gambar 24. 

 
Gambar 24. Kontur Medan Magnet Total Daerah Penelitian 
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Terlihat dari Gambar 24, secara umum pada daerah penelitian kontur 

distribusi nilai medan magnet totalnya membentuk pola yang terdiri dari tiga klosur 

yaitu klosur rendah dengan nilai medan magnet total 44.350 nT hingga 44.650 nT, 

klosur sedang dengan nilai medan magnet total 44.650 nT hingga 44.950 nT, dan 

klosur tinggi dengan nilai medan magnet total 44.950 nT hingga 45.250 nT. Daerah 

berklosur tinggi terletak di bagian tenggara dan barat laut daerah penelitian 

sedangkan daerah berklosur rendah hingga sedang terletak memanjang dari barat 

daya hingga timur laut dan memisahkan dua daerah berklosur tinggi. 

Dilihat dari formasi batuannya, Formasi Jaten dan Formasi Arjosari memiliki 

rentang nilai medan magnet total yang besar. Hal ini dikarenakan kedua formasi 

tersebut terdiri dari banyak jenis batuan yang memiliki suseptibilitas dengan 

rentang yang besar sehingga medan magnet yang ditimbulkan memiliki rentang 

yang besar pula. Formasi Jaten terdiri atas batuan konglomerat, batu pasir, batu 

pasir tufan, batu lumpur, batu lanau, lignit, serpih karbonan, dan tufa serta sedikit 

mengandung belerang, sedangkan Formasi Arjosari terdiri atas batuan konglomerat 

aneka bahan, batu pasir, batu lanau, batu gamping, batu lempung, napal pasiran, 

batu pasir berbatu apung (pumiceous sandstone), lava, dan tufa. Formasi Mandalika 

memiliki kontur medan magnet total berklosur rendah hingga sedang, Formasi 

Alluvium memiliki kontur medan magnet total berklosur sedang, sedangkan pada 

formasi batuan intrusif terlihat kontur medan magnet total berklosur tinggi yang 

merupakan hasil interpolasi dari titik-titik pengukuran di dekatnya. 
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B. Koreksi Topografi 

Koreksi topografi dilakukan untuk mengetahui adanya pengaruh ketinggian 

daerah penelitian terhadap nilai medan magnet total yang terukur. Koreksi ini hanya 

dilakukan jika pengaruh topografi terhadap medan magnet total terukur sangat 

besar,  namun jika pengaruhnya sangat kecil maka dapat diabaikan. Untuk 

mengetahui seberapa besar pengaruh topografi ini maka dilakukan perbandingan 

grafik hasil sayatan pada kontur topografi dan kontur medan magnet total. Kontur 

medan magnet total dengan sayatan TT’ ditunjukkan pada Gambar 25 dan kontur 

topografi dengan sayatan TT’ ditunjukkan pada Gambar 26. Grafik hasil sayatan 

medan magnet total ditunjukkan pada Gambar 27 dan grafik hasil sayatan topografi 

ditunjukkan pada Gambar 28. 

 
Gambar 25. Kontur Medan Magnet Total dengan Sayatan TT’.  
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Gambar 26. Kontur Topografi dengan Sayatan TT’ 

 

 

 
Gambar 27. Grafik Hasil Sayatan Medan Magnet Total  
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Gambar 28. Grafik Hasil Sayatan Topografi. 

 

 

Dari grafik hasil sayatan TT’ terlihat tinggi rendah topografi tidak 

berpengaruh pada medan magnet total sehingga dapat diambil kesimpulan bahwa 

pada penelitian ini topografi daerah penelitian tidak mempengaruhi besar medan 

magnet terukur dan tidak perlu dilakukan koreksi topografi. 

 

C. Koreksi IGRF 

Koreksi IGRF dilakukan untuk mereduksi nilai medan magnet utama bumi. 

Nilai medan magnet utama bumi ini didekati dengan nilai IGRF yang merupakan 

model dari data hasil observasi geomagnet di seluruh dunia dan direvisi setiap lima 

tahun oleh badan IAGA (International Association of Geomagnetism and 

Aeronomy). Pemodelan IGRF dapat diakses melalui website resmi NOAA 

(www.ngdc.noaa.gov).  

http://www.ngdc.noaa.gov/
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Kontur nilai IGRF daerah penelitian ditunjukkan oleh Gambar 29. Nilai IGRF 

di daerah penelitian memiliki rentang dari 45.025 nT hingga 45.130 nT, dimana 

daerah berklosur tinggi berada di sebelah timur daerah penelitian dan semakin 

rendah di sebelah barat dan utara. 

 
Gambar 29. Kontur IGRF Daerah Penelitian 

 

Koreksi ini dilakukan dengan mengurangkan nilai medan magnet total 

dengan nilai IGRF di daerah pengukuran seperti pada persamaan 10. Dari hasil 

koreksi IGRF diperoleh rentang nilai medan magnet -759,8 hingga 204,4 nT. 

 

D. Koreksi Variasi Harian 

Setelah terkoreksi IGRF kemudian dilakukan koreksi variasi harian. Koreksi 

variasi harian dilakukan untuk mereduksi nilai medan magnet luar. Nilai variasi 

harian sendiri adalah penyimpangan nilai medan magnet bumi akibat adanya 

perbedaan waktu dan efek radiasi matahari dalam satu hari dan dihitung 
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menggunakan persamaan 9. Umumnya efek radiasi matahari ini memiliki 

kecenderungan meningkat pada siang hari dan turun pada pagi dan sore hari. 

Dari hasil perhitungan diperoleh nilai variasi harian pada daerah penelitian 

dengan rentang nilai -57,61 hingga 23,21 nT. Nilai hasil koreksi IGRF dan koreksi 

variasi harian terhadap nilai medan magnet total inilah yang disebut sebagai 

anomali medan magnet. Kontur nilai anomali medan magnet ditunjukkan pada 

Gambar 30. Perhitungan nilai variasi harian ini juga dilakukan untuk mengetahui 

ada tidaknya pengaruh medan magnet dari luar bumi, seperti badai matahari dan 

aktivitas lain di lapisan ionosfer. Dampak dari badai ini kemudian didefinisikan 

sebagai Disturbance Storm Time (DST) yang direpresentasikan sebagai indeks yang 

menggambarkan gangguan pada komponen medan magnet total geomagnet saat 

terjadi badai. Klasifikasi intensitas badai geomagnet berdasarkan pola indeks DST 

ditunjukkan pada Tabel 1. Berdasarkan klasifikasi tersebut, nilai variasi harian pada 

daerah penelitian termasuk dalam kategori lemah hingga sedang, sehingga dapat 

diabaikan atau dianggap tidak berpengaruh terhadap nilai medan magnet. Hal 

tersebut juga menunjukkan bahwa selama pengukuran tidak terjadi badai 

geomagnet. 

 

E. Anomali Medan Magnet 

Medan magnet total hasil pengukuran merupakan gabungan dari medan 

magnet utama bumi, medan magnet luar dan anomali medan magnet pada titik 

pengukuran seperti ditunjukkan pada persamaan 10. Anomali medan magnet 

adalah medan magnet yang dihasilkan oleh batuan yang mengandung mineral 
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bermagnet yang berada di bawah permukaan daerah penelitian. Kontur anomali 

medan magnet daerah penelitian ditunjukkan pada Gambar 30. 

 
Gambar 30. Kontur Anomali Medan Magnet Daerah Penelitian. 

 

Gambar 30 menunjukkan pola sebaran anomali medan magnet di kawasan 

penelitian yang memiliki kisaran nilai anomali medan magnet antara -420 nT 

hingga 180 nT. Kontur anomali medan magnet daerah penelitian dapat 

dikelompokkan menjadi tiga klosur, yakni klosur rendah dengan rentang nilai 

anomali medan magnet -420 hingga -150 nT, klosur sedang dengan rentang nilai 

anomali medan magnet -150 hingga 0 nT, dan klosur tinggi dengan rentang nilai 

anomali medan magnet 0 hingga 180 nT. Dari kontur anomali di atas terlihat bahwa 

bagian barat daya daerah penelitian yang didominasi oleh Formasi Jaten 

membentuk klosur rendah hingga sedang dengan rentang yang cukup lebar 

dikarenakan formasi ini didominasi batu pasir, batu kapur, dan serpih yang juga 

diselingi sedikit batuan gunung api sehingga nilai anomali yang didapat di formasi 

ini memiliki rentang yang cukup lebar dari -260 nT hingga 60 nT. Hal yang sama 
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juga berlaku pada daerah dengan Formasi Arjosari yang paling mendominasi di 

hampir seluruh daerah penelitian. Pada Formasi Arjosari terdapat batuan gamping 

dan batuan pasir namun juga berselingan dengan batuan breksi gunung api serta 

batuan beku lainnya yang memiliki suseptibilitas relatif tinggi sehingga diperoleh 

kontur dengan rentang anomali yang sangat lebar dari -420 nT hingga 180 nT. 

Perselingan batuan beku di Formasi Arjosari terutama berada pada bagian barat laut 

daerah penelitian yang terlihat dengan klosur tinggi serta berdekatan dengan 

formasi batuan terobosan (intrusif) yang didominasi oleh batuan beku hasil intrusi 

magma gunung api purba berupa batuan andesit, batuan basalt, serta batuan diorit. 

Selain itu pada Formasi Arjosari juga terdapat daerah dengan klosur rendah yang 

berada di dekat manifestasi panas bumi Tinatar karena suhu yang tinggi di bawah 

permukaan mendemagnetisasi batuan sehingga nilai anomalinya rendah. Bagian 

timur daerah penelitian merupakan daerah berformasi alluvium yang memiliki 

klosur rendah hingga sedang dan merupakan daerah hasil endapan Sungai Grindulu 

yang didominasi oleh lumpur, pasir, dan lempung yang bersuseptibilitas rendah, 

sedangkan bagian timur laut daerah penelitian memiliki klosur rendah hingga 

sedang yang didominasi oleh batuan breksi gunung api yang berselingan dengan 

batuan lempung sehingga menimbulkan rentang anomali yang cukup lebar yaitu 

dari -320 nT hingga -60 nT serta di daerah tersebut terdapat manifestasi panas bumi 

Karangrejo yang menyebabkan sebagian daerah memiliki anomali medan magnet 

yang rendah. 
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F. Reduksi ke Kutub 

Reduksi ke kutub atau Reduction To Pole (RTP) dilakukan dengan mengubah 

parameter medan magnet bumi pada daerah penelitian yang memiliki rata-rata nilai 

deklinasi 0,94o dan inklinasi -32,9o menjadi kondisi menyerupai di kutub yang 

memiliki deklinasi 0o dan inklinasi 90o. Data anomali medan magnet yang telah  di-

RTP ditunjukkan pada Gambar 31. 

 
Gambar 31. Kontur Anomali Medan Magnet Hasil Reduksi ke Kutub. 

 

 

Terdapat perubahan rentang nilai anomali medan magnet sebelum dan 

sesudah dilakukan proses RTP. Nilai anomali medan magnet sebelum di-RTP 

berkisar antara -420 nT hingga 180 nT sedangkan setelah di RTP nilainya menjadi 

-500 hingga 200 nT. Klosur tinggi ditunjukkan dengan warna kuning – merah 

dengan rentang nilai -50 hingga 250 nT yang berada pada bagian barat hingga utara 

daerah penelitian dan klosur rendah dengan warna biru hingga hijau kekuningan 

dengan rentang nilai -400 hingga -50 nT berada di bagian timur daerah penelitian. 
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G.  Kontinuasi ke Atas 

Setelah direduksi ke kutub kemudian anomali dikontinuasi ke atas. Hal ini 

dilakukan karena anomali medan magnet masih tercampur antara anomali regional 

dan anomali lokal sehingga perlu dilakukan pemisahan antara keduanya. Proses 

pemisahan tersebut dilakukan dengan tahap kontinuasi ke atas ini, sehingga 

didapatkan anomali regional dengan cara mengurangi anomali medan magnet 

dengan anomali lokal. Kontinuasi ke atas menggunakan  proses low pass filtering, 

yaitu untuk memfilter anomali lokal dan menyisakan anomali regional saja. Proses 

ini berguna untuk mengoreksi medan potensial pada tempat yang lebih tinggi 

dibandingkan dengan ketinggian tempat pengukuran. 

Dalam penelitian ini proses kontinuasi ke atas dilakukan dengan 

pengangkatan pada ketinggian 100 m, 500 m, 800 m dan 1200 m. Hal tersebut 

dimaksudkan untuk melihat perbedaan anomali regional daerah penelitian pada 

tiap-tiap ketinggian kontinuasi yang diterapkan. Pola anomali yang sudah tidak 

menunjukkan perubahan secara signifikan dipilih sebagai dasar untuk proses 

berikutnya yaitu pemodelan 2D. Proses kontinuasi pada berbagai ketinggian 

ditunjukkan pada Gambar 32. 
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(a)                                                             (b) 

      
(c)                                                           (d) 

 

Gambar 32. Proses Kontinuasi ke Atas pada Ketinggian  (a) 100 m, (b) 500 m,  

(c) 800 m, (d) 1200 m. 

 

 

Proses kontinuasi berhenti pada ketinggian 1200 m dikarenakan pada 

ketinggian tersebut sudah nampak kontur pola anomali yang teratur dan tidak 

berubah lagi. Dapat diartikan bahwa pada ketinggian tersebut kontur yang 

dihasilkan adalah kontur anomali regional tanpa anomali lokal. Peta kontur anomali 

medan magnet hasil kontinuasi ke atas dengan ketinggian 1200 m sudah 

menggambarkan susunan batuan di daerah penelitian. Klosur tinggi menunjukkan 

keberadaan batuan dengan suseptibilitas tinggi seperti batuan beku hasil intrusi dari 

gunung api pada bagian barat hingga barat laut daerah penelitian dan klosur rendah 

menunjukkan keberadaan batuan dengan suseptibilitas rendah seperti batuan 

sedimen hasil endapan Sungai Grindulu dan batuan gunung api yang telah 
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terdemagnetisasi di bagian selatan hingga tenggara daerah penelitian. Untuk 

menjelaskan lapisan-lapisan batuan di kawasan penelitian perlu dilakukan 

pemodelan 2D dan 3D dengan menggunakan kontur anomali medan magnet hasil 

kontinuasi ke atas dengan ketinggian 1200 m. 

 

H. Pemodelan 2D dan Hasil Verifikasi Data Geologi Lapangan 

Pemodelan 2D dilakukan dengan melakukan sayatan pada hasil kontinuasi ke 

atas 1200 m di jalur-jalur tertentu sesuai dengan target penelitian. Karena target 

pada penelitian ini adalah manifestasi panas bumi Tinatar-Karangrejo, maka 

dilakukan sayatan yang melewati kedua manifestasi ini. Berdasarkan referensi yang 

diperoleh, sistem panas bumi di manifestasi panas bumi Tinatar-Karangrejo 

dikontrol oleh keberadaan sesar-sesar di sekitarnya. Oleh karena itu, untuk dapat 

mengidentifikasi lebih lanjut tentang manifestasi panas bumi Tinatar-Karangrejo, 

sayatan yang dilakukan tidak hanya menargetkan manifestasi tersebut namun juga 

sesar-sesar di sekitarnya yaitu Sesar Tinatar dan Sesar Grinjing, dimana kedua sesar 

ini merupakan sesar geser. Selain itu, pada daerah penelitian terdapat formasi 

batuan yang terlalu dominan sehingga dimungkinkan tidak terdapat kontras formasi 

batuan yang jelas.  Maka untuk memperjelas susunan batuan pada target, dilakukan 

pemodelan per blok batuan pada semua sayatan.  

Pada penelitian ini dilakukan 4 sayatan, yaitu sayatan AB yang melewati 

manifestasi panas bumi Tinatar-Karangrejo beserta kedua sesar target, sayatan CD 

yang melewati manifestasi panas bumi Karangrejo, sayatan EF yang melewati 

manifestasi panas bumi Tinatar dan Sesar Tinatar, serta sayatan GH yang melewati 
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manifestasi panas bumi Karangrejo dan Sesar Grinjing, dimana sayatan yang 

dilakukan pada hasil kontur kontinuasi ke atas 1200 m ditunjukkan pada Gambar 

33. 

 
Gambar 33. Sayatan Pada Anomali Medan Magnet Hasil Kontinuasi Ke Atas 

Dengan Ketinggian 1200 m. 

 

 

Pembuatan model 2D merujuk pada beberapa referensi yang diperoleh. 

Model 2D untuk sayatan AB dan sayatan CD merujuk pada peta geologi daerah air 

panas Tinatar dan Karangrejo hasil penyelidikan prospeksi panas bumi yang 

dikeluarkan oleh Kementrian ESDM seperti ditunjukkan pada Gambar 34.  Selain 

itu, sayatan AB juga merujuk pada peta sayatan model geologi sistem panas bumi 

Tinatar-Karangrejo dari kementrian ESDM seperti ditunjukkan pada Gambar 35, 

sedangkan untuk model 2D sayatan EF dan sayatan GH susunan batuannya merujuk 

pada peta geologi daerah air panas Tinatar dan Karangrejo namun kedalaman 

modelnya merujuk pada peta geologi lembar Pacitan.  
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Selain itu untuk memperkuat hasil pemodelan, juga dilakukan verifisikasi 

data geologi lapangan, yaitu dengan melakukan sampling batuan pada daerah yang 

dilewati sayatan. Karena pada sayatan EF dan GH tidak terdapat referensi spesifik 

tentang jenis batuan yang ada pada daerah tersebut, maka pada kedua sayatan ini 

dilakukan sampling batuan yang lebih detail.  

 

Gambar 34. Peta Geologi Daerah Air Panas Tinatar dan Karangrejo (Akbar et al., 

1993). 
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Gambar 35. Peta Model Geologi Sistem Panas Bumi Tinatar-Karangrejo (Akbar et 

al., 1993). 

 

Pembuatan model 2D dilakukan dengan mengubah-ubah parameter model 

seperti nilai suseptibilitas, lebar, kedalaman, serta bentuk blok batuan pada fitur 

gm-sys di software Oasis Montaj 6.4.2., melihat kesesuaian dengan referensi-

referensi yang diperoleh serta menyesuaikan dengan hasil verifikasi data geologi 

lapangan. 
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Pada sayatan AB dibuat model struktur bawah permukaan dengan kedalaman 

hingga 2100 m. Hal ini mengacu pada peta model geologi sistem panas bumi 

(Gambar 35) yang memiliki kedalaman kira-kira 2500 m hingga ke sumber 

panasnya, namun pada pemodelan sayatan AB model 2D yang dibuat hanya sampai 

kontak zona mineralisasi hidrotermal saja. Untuk sayatan CD, sayatan EF, dan 

sayatan GH dibuat model 2D dengan kedalaman hingga 700-900 m menyesuaikan 

dengan peta geologi hasil prospeksi panas bumi (Gambar 34). Hasil pemodelan 

struktur bawah permukaan untuk sayatan AB ditunjukkan pada Gambar 36, 

pemodelan struktur bawah permukaan untuk sayatan CD ditunjukkan pada Gambar 

37, pemodelan struktur bawah permukaan untuk sayatan EF ditunjukkan pada 

Gambar 38, dan pemodelan struktur bawah permukaan untuk sayatan GH 

ditunjukkan pada Gambar 39. Nilai suseptibilitas dan kedalaman per lapisan batuan 

ditunjukkan pada Tabel 7. 

Pemodelan 2D memiliki 2 bagian utama yaitu bagian atas yang merupakan 

bagian referensi dan bagian bawah yang merupakan bentuk model. Bagian atas 

menunjukkan nilai anomali medan magnet. Bagian bawah menunjukkan model 

struktur batuan yang terdiri dari blok-blok batuan yang memiliki nilai suseptibilitas 

dan kedalaman. Kesesuaian referensi dengan model ditunjukkan dalam angka error 

yang terletak di bagian kiri. Pada penelitian ini error pada pemodelan 2D sudah 

tergolong kecil, dimana pemodelan sayatan AB memiliki nilai error 3,598,  

pemodelan sayatan CD memiliki nilai error 2,119, pemodelan sayatan EF memiliki 

nilai error 0,650, dan pemodelan sayatan GH memiliki nilai error 0,856. 
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Tabel 7. Nilai Suseptibilitas dan Kedalaman Batuan Di Daerah 

Penelitian Berdasarkan Hasil Pemodelan 2D Sayatan AB, Sayatan CD, 

Sayatan EF, dan Sayatan GH. 

No. Model 
Suseptibilitas 

(× 10-3) (dalam SI) 
Kedalaman (m) Batuan 

1. 
 

0 – 75,60 0 - 2100 

 

Lava Andesit 

2. 
 

0 – 6,80 0 – 450 Tufa 

3. 
 

0 – 4,46 0 – 1300 Breksi Gunung Api 

4. 
 

0 – 7,70 0 – 1700 Breksi Tufa 

5. 
 

0 – 5,75 380 – 1000 Zona Mineralisasi 

6. 
 

0 – 27,45 730 – 2100 Terobosan Intra 

Miosen 

7. 
 

(-0,002) – 

(-0,0001) 

90 – 1200 Endapan Mineral 

Kuarsa dan Gypsum 

8. 
 

0,60 – 24,30 73 – 414 Diorit 

9. 
 

0 – 0,80 0 – 471 Batu Pasir 

10. 
 

0,12 0 – 180 Batu Pasir Kuarsa 

11. 
 

0,01 – 0,25 0 – 245 Batu Lempung 

12. 
 

0,06 – 0,28 0 – 309 Batu Lanau 

13. 
 

0,06 0 – 597 Granit 

14. 
 

0,35 0 – 400 Hornfels 

15. 
 

0,65 – 1,58 

 
 

0 – 570 Kuarsit 

Untuk pemodelan per blok batuan, daerah penelitian didominasi oleh batuan 

lava andesit. Batuan ini berada pada kedalaman 0 – 2100 m pada daerah dekat 
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manifestasi panas bumi dan kedalaman 500 – 2100 m di daerah yang relatif jauh 

dari manifestasi panas bumi. Batuan lava andesit di dekat manifestasi panas bumi 

Tinatar memiliki nilai suseptibilitas dalam rentang (0,1 – 5,29) × 10-3 (dalam SI) 

sedangkan di dekat manifestasi panas bumi Karangrejo batuan lava andesit ini 

memiliki nilai suseptibilitas dalam rentang (0 – 3,3) × 10-3 (dalam SI). Padahal 

merujuk pada Tabel 2, rata-rata nilai suseptibilitas batuan andesit adalah 160 × 10-

3 (dalam SI). Penurunan nilai suseptibilitas batuan ini dikarenakan menurunnya sifat 

kemagnetan batuan akibat suhu yang tinggi. Selain itu, nilai suseptibilitas batuan 

lava andesit di dekat manifestasi panas bumi Tinatar lebih besar daripada di dekat 

manifestasi panas bumi Karangrejo. Hal ini kemungkinan dikarenakan suhu air 

panas di manifestasi panas bumi Karangrejo lebih tinggi daripada suhu air panas di 

manifestasi panas bumi Tinatar sehingga batuan di dekat manifestasi panas bumi 

Karangrejo lebih terdemagnetisasi. Berdasarkan verifikasi data geologi lapangan 

yang telah dilakukan, rata-rata batuan lava andesit di dekat kedua manifestasi telah 

lapuk. Bahkan pada jarak ±20 m batuan telah menjadi soil. Batuan yang masih fresh 

diperoleh pada jarak ±100 m dari manifestasi. Perbedaan tingkat pelapukan batuan 

ini juga diperkirakan karena pengaruh kontras suhu antara panas dari dalam bumi 

dengan udara dimana batuan yang lebih dekat manifestasi panas bumi terkena panas 

yang lebih tinggi sehingga lebih cepat mengalami pelapukan. Gambar batuan lava 

andesit hasil dari verifikasi data geologi lapangan ditunjukkan pada Gambar 40. 
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a)                 b) 

 

Gambar 40. Batuan Lava Andesit Hasil Verifikasi Data Geologi Lapangan a) 

Batuan Lava Andesit yang masih fresh ditemukan ±100 m dari 

Sumber Mata Air Panas, b) Batuan Lava Andesit yang sudah lapuk 

ditemukan ±50 m dari Sumber Mata Air Panas. 

 

 

Batuan tufa pada daerah penelitian berada pada kedalaman 0 – 450 m di dekat 

manifestasi panas bumi Karangrejo dan kedalaman 0 – 400 m di dekat manifestasi 

panas bumi Tinatar. Berdasarkan hasil pemodelan, nilai suseptibilitas batuan tufa 

berada pada rentang (0 – 6,8) × 10-3 (dalam SI) dengan rata-rata nilai suseptibilitas 

batuan tufa 2,61 × 10-3 (dalam SI) di dekat manifestasi panas bumi Karangrejo dan  

5,55 × 10-3 (dalam SI) di dekat manifestasi panas bumi Tinatar. Seperti pada batuan 

lava andesit, perbedaan rata-rata nilai suseptibilitas batuan tufa ini kemungkinan 

dikarenakan suhu air panas di manifestasi panas bumi Karangrejo lebih tinggi 

daripada suhu air panas di manifestasi panas bumi Tinatar sehingga batuan di dekat 

manifestasi panas bumi Karangrejo lebih terdemagnetisasi.  

Batuan breksi gunung api pada daerah penelitian berada pada kedalaman 0 – 

1300 m. Nilai suseptibilitas batuan breksi gunung api berada pada rentang (0 – 4,46) 

× 10-3 (dalam SI) dengan rata-rata nilai suseptibilitas 2,97 × 10-3 (dalam SI). 
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Berdasarkan hasil pemodelan, batuan ini terletak di tengah-tengah antara 

manifestasi panas bumi Tinatar dan manifestasi panas bumi Karangrejo dan 

berselingan dengan batuan tufa dan breksi tufa.  

Batuan breksi tufa berada pada kedalaman 0 – 1700 m. Nilai suseptibilitas 

batuan breksi tufa pada penelitian ini berada pada rentang (0 – 7,7) × 10-3 (dalam 

SI) dengan rata-rata nilai suseptibilitas batuan breksi tufa 0,99  × 10-3 (dalam SI). 

Terdapat kontras suseptibilitas yang cukup tinggi pada jenis batuan ini, dimana 

breksi tufa yang terkontak dengan daerah mineralisasi kuarsa dan gypsum memiliki 

rentang nilai suseptibilitas (0 – 0,1) × 10-3 (dalam SI) sedangkan breksi tufa di 

tempat lainnya memiliki rentang nilai suseptibilitas (2 – 7,7) × 10-3 (dalam SI). Hal 

ini kemungkinan disebabkan oleh keberadaan endapan daerah mineral kuarsa dan 

gypsum yang merupakan jenis bahan diamagnet sehingga nilai medan magnet yang 

terbaca ketika pengukuran menjadi relatif lebih kecil daripada daerah berbatuan 

breksi tufa lain dan diperoleh model dengan nilai suseptibilitas yang lebih kecil. 

Batuan breksi tufa hasil verifikasi data geologi lapangan ditunjukkan pada Gambar 

41. 

 
Gambar 41. Batuan Breksi Tufa Hasil Verifikasi Data Geologi Lapangan. 
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Zona mineralisasi oleh media hidrotermal merupakan tempat terendapnya 

larutan hidrotermal dimana interaksi antara larutan hidrotermal dan batuan di 

sekitar akan menyebabkan terubahnya mineral-mineral penyusun batuan dan 

membentuk mineral alterasi. Pada penelitian ini zona mineralisasi hidrotermal 

berada pada kedalaman 380 – 1000 m. Berdasarkan hasil pemodelan, nilai 

suseptibilitas pada zona mineralisasi hidrotermal berada pada rentang (0 – 5,75) 

× 10-3 (dalam SI). Kecilnya nilai suseptibilitas pada zona mineralisasi hidrotermal 

ini disebabkan oleh keberadaannya yang dekat dengan sumber panas pada sistem 

panas bumi Tinatar-Karangrejo.   

Terobosan intra miosen merupakan daerah tempat berlangsungnya proses 

kontak sentuh larutan hidroternal dengan sumber panas yang kemudian terendapkan 

di zona mineralisasi. Pada daerah penelitian ini terobosan intra miosen berada pada 

kedalaman 730 – 2100 m. Nilai suseptibilitas pada terobosan intra miosen 

berdasarkan hasil pemodelan berada pada rentang (0 – 27,45) × 10-3 (dalam SI) 

dengan suseptibilitas yang semakin kecil pada blok batuan yang dekat dengan 

sumber panas pada sistem panas bumi Tinatar-Karangrejo.   

Pada bagian timur daerah penelitian terdapat daerah dugaan mineralisasi 

kuarsa dan gypsum yang terkontak dengan batuan breksi tufa dan batuan lava 

andesit. Endapan mineral kuarsa dan gypsum diperkirakan berada pada kedalaman 

90 – 1200 m. Dugaan keterdapatan mineralisasi kuarsa dan gypsum ini didasarkan 

dari hasil pemodelan dimana blok batuan ini memiliki rentang nilai suseptibilitas -

0,002 hingga -0,0001 × 10-3 (dalam SI) yang berdasarkan Tabel 5 merupakan nilai 
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suseptibilitas mineral kuarsa dan gypsum. Diduga keberadaan mineral kuarsa dan 

gypsum ini terbentuk oleh pengendapan mineral hidrotermal yang mengisi zona 

retakan di dekatnya dan terjadi di daerah dekat gunung api tersier. Dugaan ini 

diperkuat juga dengan adanya penambangan gypsum di Kecamatan Nawangan, 

yaitu di sebelah timur daerah penelitian serta ditemukannya batuan pasir kuarsa di 

di dekat daerah ini pada saat verifikasi data lapangan.  

Batuan diorit pada daerah penelitian memiliki rentang nilai suseptibilitas (0,6 

– 24,3) × 10-3 (dalam SI). Rentang nilai suseptibilitas ini sesuai dengan Tabel 2. 

Batuan diorit ini berada pada kedalaman 73 – 414 m, namun pada beberapa tempat 

berdasarkan hasil verifikasi data geologi lapangan batuan ini mengintrusi hingga 

permukaan melalui celah-celah batu lempung. Batu lempung yang ditemukan di 

sekitar intrusi batuan diorit ini diperkirakan merupakan batu lempung residu hasil 

dari lapukan batuan diorit di bawahnya. Batuan diorit dan batu lempung yang 

ditemukan di satu lokasi pada daerah penelitian ditunjukkan pada Gambar 42. 

     
a)                                          b) 

Gambar 42. Batuan Diorit dan Batu Lempung yang Ditemukan di Satu Lokasi pada 

Daerah Penelitian. a) Diorit, b) Batu Lempung. 
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Batu pasir pada daerah penelitian memiliki rentang nilai suseptibilitas (0 – 

0,8) × 10-3 (dalam SI). Rentang nilai suseptibilitas ini sesuai dengan Tabel 3. 

Berdasarkan hasil pemodelan, batu pasir berada pada kedalaman 0 – 471 m. Batu 

pasir sendiri terbentuk dari berbagai macam lapukan batuan asal, maka batu pasir 

yang ditemukan di satu tempat dan di tempat lain dapat terlihat berbeda, begitu pula 

dengan nilai suseptibilitasnya. Hal ini dikarenakan antara batu pasir yang satu 

dengan yang lain memiliki persentase mineral pembentuk yang berbeda. Di daerah 

penelitianpun ditemukan beberapa jenis batu pasir. Beberapa jenis batu pasir hasil 

verifikasi data geologi lapangan ditunjukkan pada Gambar 43. 

 
Gambar 43. Beberapa Jenis Batu Pasir Hasil Verifikasi Data Geologi Lapangan. 

 

 

Selain itu dari hasil verifikasi data geologi lapangan, batu pasir kuarsa hanya 

ditemukan pada satu tempat yaitu ±1 km di timur manifestasi panas bumi 

Karangrejo. Batu pasir kuarsa ini terdapat pada kedalaman 0 – 180 m dengan nilai 

suseptibilitas 0,12 × 10-3 (dalam SI). Genesa batu pasir kuarsa sama dengan batu 

pasir pada umumnya. Bedanya batu pasir kuarsa memiliki kandungan mineral 

kuarsa yang lebih banyak. Batu pasir kuarsa hasil verifikasi data geologi lapangan 

ditunjukkan pada Gambar 44. 
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Gambar 44. Batu Pasir Kuarsa Hasil Verifikasi Data Geologi Lapangan. 

Batu lempung pada daerah penelitian berada pada kedalaman 0 – 245 m. Nilai 

suseptibilitas batu lempung berada pada rentang (0,01 – 0,2) × 10-3 (dalam SI)  

dengan rata-rata nilai suseptibilitas 0,13 × 10-3 (dalam SI). Batu lempung pada 

daerah penelitian merupakan batu lempung residu yaitu batu lempung yang 

terbentuk dari sejenis lempung karena proses pelapukan (alterasi) batuan beku dan 

ditemukan di sekitar batuan induknya. Akibat adanya proses pelapukan ini susunan 

mineral pada batuan indukpun ikut berubah sehingga suseptibilitas batu lempung 

residu jauh lebih kecil dari suseptibilitas batuan induknya. Batu lempung hasil 

verifikasi data geologi lapangan ditunjukkan pada Gambar 45. 

 
Gambar 45. Batu Lempung Hasil Verifikasi Data Geologi Lapangan 
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Batu lanau pada daerah penelitian berada pada kedalaman 0 – 309 m. Nilai 

suseptibilitas batu lanau berada pada rentang (0,06 – 0,28) × 10-3 (dalam SI) dengan 

rata-rata nilai suseptibilitas 0,2 × 10-3 (dalam SI). Batu lanau hasil verifikasi data 

geologi lapangan ditunjukkan pada Gambar 46. 

 
Gambar 46. Batu Lanau Hasil Verifikasi Data Geologi Lapangan 

 

 

Batu granit pada daerah penelitian berada pada kedalaman 0 – 597 m. Nilai 

suseptibilitas batu granit yaitu 0,06 × 10-3 (dalam SI). Batu granit merupakan salah 

satu batuan beku asam dimana kandungan silikanya lebih banyak dari pada 

kandungan besinya sehingga memiliki suseptibilitas yang relatif lebih kecil dari 

batuan beku lain. Berdasarkan hasil verifikasi data geologi lapangan batu granit 

hanya ditemukan pada satu tempat yaitu ±100 m di timur manifestasi panas bumi 

Tinatar. Batu granit terbentuk dari proses pembekuan lava dalam suhu tinggi 

(batuan beku plutonik) sehingga batu granit dapat mudah diidentifikasi di lapangan 

karena mineral penyusunnya yang berukuran besar-besar. Lava pembentuk batu 

granit ini juga diperkirakan berasal dari gunung api tersier di dekat daerah 
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penelitian. Batu granit hasil verifikasi data geologi lapangan ditunjukkan pada 

Gambar 47. 

 
Gambar 47. Batu Granit Hasil Verifikasi Data Geologi Lapangan. 

 

Batu hornfels pada daerah penelitian berada pada kedalaman 0 – 400 m. Nilai 

suseptibilitas batu hornfels yaitu 0,06 × 10-3 (dalam SI). Berdasarkan hasil 

verifikasi data geologi lapangan, batu hornfels hanya ditemukan pada satu tempat 

yaitu ±300 m di barat manifestasi panas bumi Tinatar. Batu hornfels hasil verifikasi 

data geologi lapangan ditunjukkan pada Gambar 48. 

 
Gambar 48. Batu Hornfels yang Mengintrusi Pada Celah Batu Pasir. 
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Batu kuarsit pada daerah penelitian berada pada kedalaman 0 –  570 m. Nilai 

suseptibilitas batu kuarsit yaitu (0,65 – 1,58) × 10-3 (dalam SI). Berdasarkan hasil 

verifikasi data geologi lapangan batu kuarsit ditemukan pada kedua manifestasi 

yaitu ±200 m di sebelah utara manifestasi panas bumi Tinatar dan ±350 m di sebelah 

timur manifestasi panas bumi Karangrejo. Pada daerah penelitian diperkirakan 

batuan ini terbentuk dari batu pasir hasil pelapukan batuan lava andesit yang 

kemudian mengalami metamorfisme akibat letaknya yang berdekatan dengan 

tempat munculnya sumber mata air panas. Batu kuarsit hasil verifikasi data geologi 

lapangan ditunjukkan pada Gambar 49. 

    
a)                                                b) 

Gambar 49. Batu Kuarsit Hasil Verifikasi Data Geologi Lapangan. a) Batu Kuarsit 

yang Ditemukan ±350 m di Sebelah Timur Manifestasi Panas Bumi 

Karangrejo, b) Batu Kuarsit yang Ditemukan ±200 m di Sebelah Utara 

Manifestasi Panas Bumi Tinatar. 

 

Hasil pemodelan 2D ini jika dibandingkan dengan referensi dan hasil 

verifikasi data lapangan sudah memiliki kesesuaian. Untuk memperjelas bentuk 

pemodelan maka dilakukan pemodelan 3D dengan menggunakan software 

Rockwork. 
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I. Pemodelan 3D 

Pemodelan 3D dilakukan pada kontur anomali medan magnet yang telah 

direduksi ke kutub. Untuk memperoleh rentang nilai tertinggi dan terendah pada 

peta kontur maka dilakukan sayatan EE’ seperti ditunjukkan pada Gambar 50. 

Sample nilai anomali medan magnet menggunakan interval 50 m. Pemodelan 3D 

didasarkan pada nilai suseptibilitas batuan di sekitar kawasan penelitian. Untuk 

memudahkan pembahasan model 3D, maka dilakukan analisis data berdasarkan 

iso-level nilai suseptibilitas daerah penelitian.  Hasil pemodelan 3D yang belum 

dilakukan analisis iso-level nilai suseptibilitas ditunjukkan pada Gambar 51. 

 
Gambar 50.  Sayatan Pada Anomali medan Magnet Hasil Reduksi Ke Kutub. 
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Gambar 51. Hasil Pemodelan 3D Tampak Atas Sebelum Analisis Iso-Level. 

 

 

Pada Gambar 51 terlihat bahwa hasil pemodelan 3D daerah penelitian dapat 

dibagi menjadi dua klosur yaitu klosur rendah berwarna magenta hingga toska 

dengan rentang nilai suseptibilitas (0 - 2,578) × 10-3 (dalam SI) dan klosur tinggi 

berwarna toska hingga merah  dengan rentang nilai suseptibilitas (2,578 – 5,578) 

× 10-3 (dalam SI).  

Daerah berklosur rendah mendominasi hampir seluruh daerah penelitian dari 

ujung selatan hingga tengah daerah penelitian. Daerah ini merupakan daerah 

berformasi batuan alluvium, Formasi Jaten, dan sebagian Formasi Arjosari, dimana 

pada formasi-formasi batuan tersebut didominasi oleh batuan jenis sedimen seperti 

batu gamping, batu pasir, batu lempung, dan batu lanau sehingga memiliki nilai 

suseptibilitas yang relatif rendah. Namun demikian sebagian daerah pada Formasi 

Arjosari adalah daerah berbatuan beku vulkanik yang umumnya memiliki nilai 
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suseptibilitas tinggi. Rendahnya nilai suseptibilitas batuan beku vulkanik pada 

Formasi Arjosari ini disebabkan oleh adanya sumber panas di bawah permukaan 

daerah tersebut sehingga mendemagnetisasi batuan beku vulkanik di sekitarnya.  

Daerah berklosur tinggi terutama berada di ujung utara daerah penelitian yang 

menipis di tengah dan sedikit melebar di bagian barat dan timur. Tingginya nilai 

suseptibilitas ini dikarenakan pada daerah tersebut didominasi oleh batuan beku 

vulkanik seperti andesit dan diorit pada formasi batuan intrusif dan Formasi 

Mandalika. Hasil pemodelan 3D ini sesuai dengan peta geologi lembar Pacitan yang 

ditunjukkan pada Gambar 52. 

  
Gambar 52. Peta Geologi Lembar Pacitan (Samodra et al., 1992). 

 

Analisis iso-level pada pemodelan 3D ini dilakukan dari nilai suseptibilitas 

terendah hingga tertinggi. Dengan analisis iso-level dapat dikelompokkan daerah 

bersuseptibilitas sama sehingga lebih mudah diinterpretasikan. Hasil analisis iso-

level ditunjukkan pada Gambar 53-55. 
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Gambar 53. Hasil Iso-Level Pemodelan 3D Dengan Nilai Suseptibilitas (0,686-

5,578) × 10-3 (dalam SI). 

 

Pada Gambar 53 terlihat bahwa daerah berwarna magenta yang memiliki 

suseptibilitas (0-0,686) × 10-3 (dalam SI) hilang setelah analisis iso-level ini, yaitu 

terutama daerah di bagian selatan daerah penelitian dari permukaan hingga 

kedalaman 500 m, dimana daerah tersebut merupakan daerah berformasi batuan 

Wuni, alluvium, dan Jaten yang didominasi oleh pasir, batu pasir, batu lanau, dan 

batu gamping. Nilai suseptibilitas ini sesuai dengan hasil pemodelan 2D pada Tabel 

6, dimana pada daerah penelitian batu pasir memiliki rentang suseptibilitas (0 – 0,8) 

× 10-3 (dalam SI), batu lanau memiliki rentang suseptibilitas (0,06 – 0,28) × 10-3 

(dalam SI). Sedangkan batu gamping tidak terdapat pada daerah sayatan pemodelan 

2D. Selain daerah di bagian selatan daerah penelitian terdapat dua daerah yang 

hilang di tengah-tengah daerah penelitian. Daerah-daerah tersebut merupakan 
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daerah tempat manifestasi panas bumi Tinatar dan Karangrejo, dimana pada daerah-

daerah tersebut didominasi oleh batuan beku vulkanik berupa andesit dan diorit, 

batuan piroklastik berupa tufa dan breksi, serta karena letaknya yang dekat dengan 

daerah manifestasi panas bumi maka terdapat daerah mineralisasi hidrotermal 

berupa dugaan endapan mineral gypsum dan kuarsa. Rendahnya nilai suseptibilitas 

disebabkan oleh adanya demagnetisasi batuan karena letaknya yang dekat dengan 

sumber mata air panas. 

Selanjutnya untuk hasil iso-level dengan nilai suseptibilitas (1,25-5,578) 

× 10-3 (dalam SI) ditunjukkan pada Gambar 54, daerah berwarna ungu dan biru tua 

pada Gambar 53 hilang, sehingga dapat diperkirakan daerah berwarna ungu tersebut 

memiliki nilai suseptibilitas antara (0,686-1,25) × 10-3 (dalam SI). Daerah tersebut 

masih sama seperti hasil analisis iso-level suseptibilitas (0,686-5,578) × 10-3 (dalam 

SI) yang merupakan daerah berformasi Arjosari dan dominan batuan piroklastik 

namun memiliki suseptibilitas yang sedikit lebih besar karena letaknya yang sedikit 

lebih jauh dari sumber panas. Sedangkan warna biru di tengah-tengah daerah 

penelitian dengan nilai suseptibilitas 1,578 × 10-3 dalam `SI diperkirakan 

merupakan batuan beku vulkanik namun karena letaknya jauh dari sumber panas 

maka nilai suseptibiltasnya relatif lebih tinggi daripada batuan beku vulkanik yang 

dekat dengan sumber panas. 
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Gambar 54. Hasil Iso-Level Pemodelan 3D Dengan Nilai Suseptibilitas (1,25-

5,578)  × 10-3 (dalam SI). 

 

Kemudian untuk hasil iso-level dengan nilai suseptibilitas (1,810-5,578) 

× 10-3 (dalam SI) yang ditunjukkan pada Gambar 55 terlihat bahwa pada daerah 

penelitian hanya bersisa daerah berwarna toska hingga merah dengan nilai 

suseptibilitas (1,81-5,578) × 10-3 (dalam SI). Daerah-daerah ini merupakan daerah 

berbatuan gunung api. Terutama di bagian barat laut daerah penelitian terdapat 

formasi batuan terobosan/intrusi berupa batuan dasit, diorit, basalt, dan andesit serta 

di bagian timur laut daerah penelitian juga terdapat intrusi diorit sehingga memiliki 

suseptibilitas yang besar. 
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Gambar 55. Hasil Iso-Level Pemodelan 3D Dengan Nilai Suseptibilitas (1,81-

5,578) × 10-3 (dalam SI). 

 

Hasil pemodelan 3D ini jika dibandingkan dengan referensi peta geologi, hasil 

verifikasi data lapangan, dan hasil pemodelan 2D sudah memiliki kesesuaian. 

Selanjutnya dilakukan identifikasi litologi dan identifikasi pengaruh keberadaan 

sesar terhadap kemunculan manifestasi panas bumi Tinatar-Karangrejo. 

 

J. Identifikasi Litologi 

Litologi adalah deskripsi batuan berdasarkan karakter fisiknya. Dalam 

penelitian ini karakter fisik yang dibahas adalah suseptibilitas magnet. Berdasarkan 

hasil penyelidikan geologi panas daerah panas bumi Tinatar-Karangrejo oleh Akbar 

et al. (1993) diperkirakan bahwa litologi pada daerah penelitian merupakan produk 

dari gunung api yang aktif pada zaman tersier. Gunung api tersebut terbentuk akibat 
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penunjaman Lempeng Indo-Australia dengan Lempeng Eurasia dan termasuk 

dalam deretan busur vulkanik Jawa.  

Produk dari gunung api tersier ini adalah batuan beku vulkanik yang berasal 

dari lava serta batuan piroklastik yang berasal dari material seperti kerikil, pasir, 

dan debu yang terlempar saat terjadi erupsi. Batuan beku vulkanik ini diperkirakan 

merupakan batuan dasar pada daerah penelitian. Batuan beku vulkanik pada daerah 

penelitian terdiri atas lava andesit, diorit dan granit. Karena perbedaan kondisi dan 

lingkungan pembekuan batuan, maka sifat-sifat fisik dari batuan lava dan granit 

menjadi berbeda termasuk suseptibilitas magnetnya dimana lava yang membeku di 

atas permukaan menjadi batuan andesit atau diorit sedangkan yang membeku di 

dekat permukan menjadi batuan granit. Suseptibilitas batuan lava andesit berkisar 

antara 0 hingga 75,6 × 10-3 (dalam SI), suseptibilitas batuan diorit berkisar antara 

0,60 hingga 24,30 × 10-3 (dalam SI), sedangkan suseptibilitas batuan granit 0,06 

× 10-3 (dalam SI). Batuan lava andesit, granit, dan diorit ini merupakan batuan dasar 

di daerah penelitian. 

Batuan piroklastik pada daerah penelitian terdiri atas tufa, breksi, dan breksi 

tufa. Batuan yang terbentuk dari material-material halus seperti pasir dan abu 

vulkanik terendapkan disebut batuan tufa, sedangkan yang terbentuk dari material-

material vulkanik yang lebih kasar terendapkan disebut batuan breksi. Selain itu 

terdapat juga batuan breksi yang bahan perekat antar fragmennya merupakan 

batuan yang berasal dari material vulkanik halus yang disebut dengan batuan breksi 

tufa dan memiliki sifat fisik antara batuan breksi dan batuan tufa. Batuan-batuan 

piroklastik ini memiliki kisaran nilai suseptibilitas 0 hingga 7,7 × 10-3 (dalam SI). 
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Batuan piroklastik umurnya lebih muda dari batuan dasar sehingga berdasarkan 

hukum superposisi geologi lapisan batuan yang umurnya lebih muda selalu berada 

di atas lapisan batuan yang umurnya lebih tua. Oleh karena itu batuan breksi, tufa 

dan breksi tufa letaknya dalam stratigrafi selalu di atas lapisan batuan andesit, 

granit, dan diorit. 

Seiring berjalannya waktu lama-kelamaan batuan-batuan beku dan 

piroklastik tersebut akan mengalami pelapukan terutama yang letaknya dekat 

permukaan menjadi butiran-butiran halus dan terbawa angin maupun air sehingga 

mengalami sedimentasi (pengendapan) di suatu tempat menjadi batuan sedimen 

klastik. Batuan baru hasil endapan butiran berdiameter di antara 0,0625 - 2 mm 

disebut sebagai batu pasir, batuan hasil endapan butiran berdiameter sekitar 0,002 

mm disebut sebagai batu lempung, dan batuan hasil endapan butiran berdiameter di 

antara 2–62 µm disebut sebagai batu lanau. Karena telah mengalami pelapukan 

maka susunan mineralnya pun telah berubah sehingga batuan-batuan sedimen ini 

memiliki sifat fisik yang sangat berbeda dari batuan induknya (batuan gunung api). 

Pada umumnya batuan gunung api memiliki suseptibilitas dan densitas yang relatif 

besar namun batuan-batuan sedimen ini memiliki suseptibilitas dan densitas yang 

lebih kecil daripada batuan gunung api. Nilai suseptibilitas batuan-batuan sedimen 

klastik ini berkisar antara 0 hingga 0,8 × 10-3 (dalam SI). Karena umur yang lebih 

muda maka batuan-batuan sedimen klastik letaknya selalu di atas batuan gunung 

api dalam stratigrafi.  

Selain batuan beku vulkanik, batuan piroklastik, dan batuan sedimen klastik, 

terdapat pula batuan metamorf. Batuan metamorf yang ditemukan pada daerah 
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penelitian adalah berupa kuarsit dan hornfels. Batu kuarsit terbentuk dari batu pasir 

hasil pelapukan batuan lava andesit yang kemudian mengalami metamorfisme oleh 

tekanan dan temperatur tinggi, sedangkan batu hornfels terbentuk dari tanah liat dan 

batu pasir yang juga mengalami proses metamorfosis oleh temperatur dan tekanan 

yang tinggi. Temperatur dan tekanan tinggi ini terjadi di dekat gunung api aktif saat 

itu. Batuan metamorf ini memiliki kisaran nilai suseptibilitas antara 0,35 hingga 

1,58 × 10-3 (dalam SI). Batuan metamorf ini letaknya relatif sejajar dengan batuan 

sedimen.  

 

K. Identifikasi Pengaruh Keberadaan Sesar Terhadap Kemunculan 

Manifestasi Panas Bumi Tinatar-Karangrejo 

 

Daerah penelitian yang berada pada lingkungan busur vulkanik dimana di 

bawahnya terdapat ruang-ruang magma yang berperan sebagai sumber panas 

menyebabkan munculnya manifestasi panas bumi. Manifestasi yang muncul berupa 

mata air panas. Mata air panas ini berasal dari air meteorik (air hujan) yang meresap 

ke bawah permukaan melalui bahan berpermeabilitas tinggi seperti tanah dan batu 

pasir yang kemudian terakumulasi di sela-sela batuan breksi yang memiliki 

porositas tinggi dan berperan sebagai batuan reservoir. Karena batuan breksi 

letaknya dekat dengan terobosan intra miosen yang terkontak langsung dengan 

sumber panas, maka terjadi perpindahan panas secara konduksi dari batuan 

terobosan intra miosen ke batuan di sekitarnya termasuk batuan breksi sehingga air 

meteorik yang terakumulasi dalam batuan breksi tersebut ikut terpanaskan. Akan 

tetapi pada sistem panas bumi Tinatar-Karangrejo diperkirakan batuan terobosan 

intra miosen memiliki konduktivitas termal yang tidak sama ke semua arah. Hal ini 
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menyebabkan panas merambat dengan laju yang berbeda ke arah yang berlainan, 

dimana panas merambat lebih cepat di batuan dekat manifestasi panas bumi 

Karangrejo dibandingkan dengan batuan dekat manifestasi panas bumi Tinatar. Hal 

ini pula yang menyebabkan suhu mata air panas Karangrejo lebih tinggi daripada 

suhu mata air panas Tinatar.  

Setelah air di reservoir tersebut terpanaskan maka akan terjadi perpindahan 

panas sehingga suhu air menjadi lebih tinggi dan air menjadi lebih ringan. Keadaan 

ini menyebabkan air yang lebih panas bergerak ke atas dan air yang lebih dingin 

bergerak ke bawah, sehingga terjadi sirkulasi air atau arus konveksi. Lama-

kelamaan  suhu air meningkat, volume bertambah, dan tekanan menjadi naik. 

Tekanan yang terus meningkat, membuat air panas tersebut kemudian mencari jalan 

untuk sampai ke permukaan. Karena batuan memiliki permeabilitas yang tidak 

sama ke semua arah dimana permeabilitas horizontal lebih besar daripada 

permeabilitas vertikalnya, maka air panas akan cenderung mencari jalan ke 

samping, dimana di sisi-sisi batuan breksi didominasi oleh batuan lava andesit. 

Permeabilitas batuan lava andesit sendiri sebenarnya sangat kecil. Akan tetapi 

karena adanya struktur sesar pada batuan ini yang berperan sebagai permeabilitas 

sekunder sehingga air panas dapat sampai ke permukaan. 

Struktur sesar ini diperkirakan ada karena aktivitas gunung api tersier yang 

menyebabkan batuan lava andesit di sekitarnya mengalami deformasi yang 

melampaui ambang batas elastisitas batuan tersebut. Struktur sesar ini terdapat pada 

kedua manifestasi baik di Tinatar maupun di Karangrejo. Menurut Abdullah et al. 

(2003), Sesar Tinatar diperkirakan merupakan jenis sesar geser berarah hampir 
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barat laut-tenggara, sedangkan Sesar Grinjing merupakan sesar geser berarah 

hampir utara-selatan. Karena merupakan jenis sesar geser, maka tidak terlihat 

adanya kontras nilai suseptibilitas pada kedua sisi bidang sesar, sehingga untuk 

memperkuat bukti adanya sesar dilakukan survei geologi lapangan dan identifikasi 

adanya pergeseran jalur sungai di dekat dugaan sesar. Keberadaan sesar ini 

dibuktikan dengan ditemukannya singkapan batuan lava andesit yang mengalami 

retakan tidak jauh dari manifestasi panas bumi Tinatar seperti ditunjukkan pada 

Gambar 57 dan juga adanya pergeseran jalur aliran Sungai Pacitan dan Sungai 

Brungkah yang berada di dekat manifestasi panas bumi seperti ditunjukkan pada 

Gambar 56. 

 
Gambar 56. Bukti Terdapatnya Sesar Dari Pergeseran Jalur Sungai. 
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Gambar 57. Bukti Terdapatnya Sesar Di Dekat Manifestasi Panas Bumi Tinatar. 
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BAB V 

KESIMPULAN DAN SARAN 

A. Kesimpulan 

Berdasarkan penelitian “Identifikasi Litologi Bawah Permukaan Daerah 

Manifestasi Panas Bumi Tinatar-Karangrejo Kabupaten Pacitan Menggunakan 

Metode Geomagnet” dapat diambil kesimpulan sebagai berikut: 

1. Nilai anomali medan magnet pada daerah penelitian berkisar antara -420 nT 

hingga 180 nT dan terbagi menjadi tiga klosur, yaitu: tinggi, sedang, dan rendah. 

Klosur tinggi berada pada bagian barat laut daerah penelitian dengan rentang 

nilai 0 nT hingga 180 nT. Klosur sedang berada pada bagian tenggara daerah 

penelitian dengan rentang nilai -150 nT hingga 0 nT. Klosur rendah berada pada 

bagian barat daya memanjang hingga timur laut daerah penelitian dengan 

rentang nilai -420 nT hingga -150 nT. 

2. Struktur litologi bawah permukaan daerah penelitian memiliki nilai 

suseptibilitas yang berkisar antara -0,002 hingga 75,600 × 10-3 (dalam SI) dan 

terdiri oleh batuan lava andesit, tufa, breksi gunung api, breksi tufa, diorit, batu 

pasir, batu pasir kuarsa, batu lempung, batu lanau, kuarsit, dan hornfels. Batuan 

beku (lava andesit, diorit, dan granit) merupakan batuan dasar daerah penelitian 

yang berada pada kedalaman 0−2100 m dengan kisaran nilai suseptibilitas 0 

hingga 75,6 × 10-3 (dalam SI). Di atas batuan beku terdapat batuan-batuan 

sedimen vulkanik (breksi gunung api, tufa, dan breksi tufa) yang berada pada 

kedalaman 0−1700 m  dan memiliki nilai suseptibilitas 0 hingga 7,7 × 10-3 

(dalam SI). Pada bagian paling atas terdapat batuan sedimen klastik (batu pasir, 
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batu pasir kuarsa, batu lempung, dan batu lanau) yang berada pada kedalaman 

0−471 m dan memiliki nilai suseptibilitas 0 hingga 0,8 × 10-3 (dalam SI) dan 

batuan metamorf (kuarsit dan hornfels) yang berada pada kedalaman 0−570 m 

dan memiliki nilai suseptibilitas 0,35 hingga 1,58 × 10-3 (dalam SI). 

3. Sesar Tinatar dan Sesar Grinjing berperan sebagai media keluarnya air panas ke 

permukaan. Sesar Tinatar merupakan sesar geser dengan arah hampir barat laut-

tenggara, sedangkan Sesar Grinjing merupakan sesar geser dengan arah hampir 

utara-selatan. Keberadaan kedua sesar diperkuat dengan adanya pergeseran jalur 

sungai pada Sungai pacitan dan Sungai Brungkah. 

 

B. Saran 

1. Perlu dilakukan penelitian lanjutan dengan metode geofisika yang lain, seperti 

metode geolistrik dan magnetotellurik sehingga dapat memperkuat hasil 

penelitian. 

2. Perlu dilakukan pengukuran parameter-parameter sesar, seperti dip dan strike 

pada struktur-struktur batuan yang ditemukan pada saat verifikasi data geologi 

lapangan. 
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Lampiran 1. Data Hasil Pengukuran 

 

Daerah        : Punung, Pringkuku, dan Arjosari Kabupaten Pacitan 

Tanggal      : 21-23 Agustus 2017 

Metode : Geomagnet 

 

 

 

Nama Titik 
Koordinat Elevasi 

(mdpl) 
Waktu Pembacaan (nT) 

X Y 

BASE 509779 9103163 480 

08.04 45079 

08.04 45081 

08.04 45085 

08.04 45087 

08.05 45062 

A01 507672 9103904 449.1 

08.33 45094 

08.33 45137 

08.33 45112 

08.33 45090 

08.33 45106 

A06 507993 9104403 439.4 

08.52 45056 

08.52 45126 

08.52 45091 

08.52 45095 

08.52 45125 

T01 508396 9104231 392.1 
09.23 45072 

09.23 45166 
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09.23 45211 

09.23 45169 

09.23 45153 

BASE 509779 9103163 480 

09.57 45109 

09.57 45119 

09.57 45121 

09.57 45109 

09.57 45102 

A02 508275 9102837 464.6 

10.19 45372 

10.40 44956 

10.40 44976 

10.40 44954 

10.40 44969 

A04 509823 9100821 435.5 

11.23 44810 

11.23 44819 

11.23 44828 

11.23 44834 

11.25 44813 

A03 508663 9103441 476.4 

12.30 44809 

12.30 44813 

12.30 44832 

12.30 44818 

12.30 44804 

BASE 509779 9103163 480 

13.15 45134 

13.15 45087 

13.15 45125 

13.15 45133 
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13.15 45125 

A08 510054 9102912 475.8 

13.40 45012.9 

13.40 45014.2 

13.40 45015.7 

13.40 45012.6 

13.42 45015.5 

A09 510786 9102676 466.0 

14.28 45111 

14.28 45116 

14.29 45109 

14.29 45118 

14.30 45132 

A10 511669 9104867 232.9 

14.57 44902 

14.57 44936 

14.58 44912 

14.58 44923 

14.58 44913 

BASE 509779 9103163 480 

15.27 45033 

15.28 45046 

15.28 45036 

15.28 45028 

15.29 45089 

A07 509313 9103751 470.2 

16.11 44972 

16.11 44965 

16.11 44964 

16.12 44962 

16.12 44903 

BASE 509779 9103163 480 16.24 45048 
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16.24 45000 

16.25 45015 

16.25 45069 

16.26 45013 

BASE 513834 9102920 38 

08.07 45040 

08.07 45036 

08.07 45065 

08.07 45069 

08.07 45075 

A20 513645 9102854 48 

08.21 45032 

08.21 45041 

08.21 45046 

08.21 45034 

08.21 45067 

A15 512823 9102285 22 

08.41 45026 

08.41 45009 

08.41 45021 

08.42 45001 

08.42 45015 

A14 511830 9102758 270 

09.22 45058 

09.22 45045 

09.23 45102 

09.23 45103 

09.24 45108 

Geologi 511745 9102655 281 

09.34 45282 

09.35 45257 

09.36 45233 
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09.37 45246 

09.37 45220 

A19 512657 9103784 38  

10.23 45020 

10.23 45047 

10.23 45051 

10.23 45043 

10.23 45045.4 

BASE 513834 9102920 38  

10.46 45032 

10.46 45058 

10.47 45060 

10.48 45046 

10.48 45033 

A25 514274 9103716 73 

11.07 45055 

11.08 45057.5 

11.08 45055 

11.12 45060 

11.17 45060 

A24 514008 9104562 231 

11.38 44910 

11.39 44911 

11.39 44910 

11.39 44922 

11.40 44918 

A23 513617 9106067 517 

12.28 44899 

12.28 44868 

12.29 44866 

12.31 44892 

12.31 44880 
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BASE 513834 9102920 38 

14.19 45014 

14.19 45028 

14.19 45026 

14.20 45011 

14.20 45011 

A30 515172 9104595 57 

14.43 45000 

14.46 44976 

14.48 45015 

14.49 45000 

14.49 44965 

A29 514837 9105852 64 

15.19 44757 

15.20 44777 

15.31 44733 

15.32 44753 

15.32 44750 

A28 514036 9106700 319 

16.40 44944 

16.40 44979 

16.41 44928 

16.41 44929 

16.41 44929 

BASE 513834 9102920 38 

18.06 45035 

18.07 45045 

18.07 45048 

18.07 45040 

18.07 45036 

BASE 510354 9105596 96 
09.26 44909 

09.26 44881 
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09.26 44871 

09.26 44850 

09.26 44873 

G0 511316 9105092 92 

10.44 45390 

10.44 45601 

10.44 45548 

10.44 45566 

10.45 45565 

G1 511209 9105059 121 

11.08 45154 

11.08 45070 

11.08 45085 

11.10 45137 

11.11 45103 

G2 511161 9105032 130 

11.24 45063 

11.25 45047 

11.28 45062 

11.29 45037 

11.29 45095 

BASE 510354 9105596 96 

12.24 44883 

12.25 44880 

12.28 44882 

12.29 44883 

12.29 44883 

A17 511082 9105602 146 

12.37 45030 

12.37 44953 

12.37 45030 

12.39 44952 
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12.39 44959 

A18 511410 9104856 84 

13.15 45036 

13.15 45038.1 

13.20 45032.2 

13.20 45034 

13.21 45036 

T02 511663 9104071 85 

13.35 44690 

13.36 44654 

13.37 44683 

13.37 44684 

13.38 44624 

G3 514376 9105658 73 

14.32 45318 

14.32 45378 

14.32 45389 

14.32 45389 

14.32 45314 

BASE 510354 9105596 96 

15.29 44810 

15.29 44826 

15.29 44806 

15.29 44803 

15.29 44817 

A13 510779 9104171 334 

16.00 44740 

16.00 44737 

16.01 44755 

16.01 44756 

16.01 44750 

A12 510194 9105003 303 16.22 45058 
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16.22 45053 

16.22 45088 

16.22 45047 

16.22 45052 

A11 509858 9105780 203 

16.34 45218 

16.34 45247 

16.41 45256 

16.41 45265 

16.42 45261 

A16 510324 9106573 197 

17.01 45093 

17.01 45098 

17.02 45109 

17.02 45065 

17.02 45066 

BASE 510354 9105596 96 

17.27 44791 

17.28 44805 

17.28 44776 

17.28 44784 

17.28 44790 
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Lampiran 3. Tahap Pembuatan Desain Survei 

A. Register Peta Geologi 

1. Buka software Global Mapper 13 ➔Klik Open Your Own Data Files. 

 
Gambar L1. Membuka Software Global Mapper 13. 

 

2. Setelah muncul dialog Open, kemudian pilih file gambar peta geologi yang akan 

diregister➔ Open ➔ Yes. 
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Gambar L2. Memilih File Gambar Peta Geologi Yang Akan Diregister. 

3. Setelah muncul dialog Image Rectifier (Gambar L3), pilih Select Option 

kemudian pilih proyeksi koordinat yang diinginkan pada Projection dimana 

koordinat yang umum digunakan adalah format UTM atau Geographic (Gambar 

L4). 

 
Gambar L3. Tampilan Dialog Image Rectifier 
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Gambar L4. Memilih Proyeksi Koordinat 

4. Pada kotak Entire Image, pilih salah satu ujung peta hingga membentuk persegi 

panjang, dimana ujung yang dipilih tadi akan ditampilkan pada kotak Zoomed 

View. Di kotak Zoomed View, klik tepat pada pojok ujung peta hingga muncul 

titik merah seperti ditunjukkan pada Gambar L5. 

 
Gambar L5. Memilih Titik Ujung Peta Yang Akan Diregister. 

 

5. Setelah memilih titik pojok peta, kemudian mengisi titik koordinat yang 

tercantum di pojok peta di Ground Control Point (GCP) Entry (Dapat berupa 

koordinat UTM maupun Geographic ) seperti pada Gambar L6. 
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Gambar L6. Mengisi Titik Koordinat Di Ground Control Point (GCP) Entry. 

 

6. Kemudian klik pada Add Point to List setelah muncul dialog Ground Control 

Point Name, beri nama titik sesuai keinginan kemudian pilih OK seperti pada 

Gambar L7. 

 
Gambar L7. Memberi Nama Titik Koordinat 

 

 

 

7. Ulangi langkah 4 sampai 6 pada ketiga ujung peta lainnya. Setelah itu akan 

muncul tampilan GCP Points seperti pada Gambar L8. Kemudian pilih OK, 

hingga muncul tampilan seperti Gambar L9. 

  

Gambar L8. Klik OK setelah Semua Titik Koordinat Terisi. 
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Gambar L9. Tampilan Global Mapper 13 Setelah Peta Selesai Diregister. 

 

 

8. Untuk memotong peta agar lebih spesifik pada daerah penelitian, klik pada menu 

File ➔ Export Raster Image Format. Pada dialog Select Export Format pilih 

GeoTIFF ➔ OK. Setelah itu akan muncul dialog GeoTIFF Export Option pilih 

Export Bounds ➔ Draw a Box kemudian akan muncul dialog Draw a Box to 

Selects Export Bounds. Pada dialog tersebut dipilih dan ditentukan luas daerah 

penelitian dengan cara membentuk persegi dengan garis kuning seperti pada 

Gambar L10. Kemudian pilih OK. Kemudian pilih GeoTIFF Option simpan file 

dalam format GeoTIFF (ekstensi *.tiff). 
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Gambar L10. Memilih dan Menentukan Luas Daerah Penelitian 

 

 

B. Pembuatan Desain Survei 

1. Buka software Surfer 12, pilih menu Map ➔ New ➔ Base Map, kemudian pilih 

peta geologi yang telah diregister dan dipotong tadi. 

2. Kemudian untuk dapat membuat desain survei, terlebih dahulu harus diketahui 

letak target penelitian. Setelah diketahui letak target penelitian, dipilih salah satu 

titik dekat target dengan cara  pilih menu Map ➔ Digitize. Kemudian klik pada 

salah satu titik dekat target sesuai keinginan hingga muncul dialog Digitized 

Coordinates seperti pada Gambar L11. 
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Gambar L11. Memilih Salah satu Titik di Dekat Target Penelitian. 

 

 

3. Pilih koordinat yang muncul pada dialog Digitized Coordinates kemudian pilih 

Edit ➔ Copy.  

4. Kemudian pilih menu File ➔ New ➔ Worksheet. Setelah muncul worksheet 

baru, kemudian pastekan koordinat yang telah dicopy tadi seperti pada Gambar 

L12. 
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. 

Gambar L12. Tampilan Koordinat yang Telah Dipastekan di Worksheet. 

 

 

5. Copy lagi koordinat pada worksheet kemudian di software Microsoft Excel pilih 

menu Home ➔ Paste. 

6. Karena yang dipilih baru satu titik koordinat, maka harus ditentukan tiitk-titik 

koordinat yang lain dengan menjumlah atau mengurangkan titik koordinat awal 

tadi, dimana nilai yang dijumlahkan ini merupakan jarak antar titik penelitian 

yang diinginkan seperti pada Gambar L13. 

7. Setelah selesai menentukan koordinat, edit file dengan format kolom A= 

Koordinat X, kolom B = Koordinat Y, dan kolom C = nama titik. Kemudian 

copy keseluruhan koordinat. 
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Gambar L13. Menentukan Titik-Titik Koordinat Dengan Software Microsoft Excel. 

 

8. Buka kembali software Surfer 12, buka worksheet kemudian pastekan titik-titik 

koordinat yang telah dicopy tadi, kemudian save file dalam ekstensi .txt. 

9. Untuk memasukkan titik-titik koordinat pada peta geologi, masih pada software 

Surfer 12, buka plot peta geologi kemudian pilih Map ➔ Add ➔ Post Layer. 

Pilih file yang telah disimpan dalam ekstensi .txt tadi hingga muncul tampilan 

seperti pada Gambar L14. Titik-titik koordinat dapat diedit sesuai keinginan 

dengan memilih Post pada kotak Object Manager kemudian dapat diedit pada 

kotak Property Manager. 
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Gambar L14. Memasukkan Titik-Titik Koordinat pada Peta Geologi 
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Lampiran 4. Tahap Pengolahan Data 

A. Koreksi IGRF 

 

1. Mengakses website NOAA pilih Geomagnetic Data and Models ➔ Magnetic 

Fields pada pilihan Online Calculators ➔ Magnetic Fields maka akan muncul 

dialog Magnetic Field Estimated Values. Pada kolom Latitude dan Longitude 

diisi dengan koordinat titik pengambilan data dalam bentuk koordinat geografi 

dan diperhatikan pula lokasi penelitian pada lokasi lintang utara atau lintang 

selatan dan bujur barat atau bujur timur, pada kolom Elevation dipilih Mean Sea 

Level dan satuan dalam meter, Start Date dan End Date dipilih hari selama 

pengambilan data, maka akan muncul informasi nilai IGRF di satu titik 

penelitian pada koordinat tersebut  seperti pada Gambar L15. 
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Gambar L15. Informasi Nilai IGRF Di Salah Satu Titik Pengambilan Data   

Penelitian 

 

 

2. Copy nilai IGRF dari tiap-tiap titik penelitian dan simpan. 

 

B. Menghitung Nilai Anomali Medan Magnet 

1. Buka software Microsoft Excel lalu masukkan data hasil penelitian (nama titik, 

koordinat xyz, nilai medan magnet total yang terbaca serta waktu pengambilan 

data baik di base maupun di rover) juga nilai IGRF dari web NOAA seperti pada 

Gambar L16. 
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.  

Gambar L16. Tampilan Data Hasil Penelitian 

 

2. Hitung rerata pembacaan nilai medan magnet total baik base maupun rover. 

3. Hitung nilai variasi harian dengan menggunakan persamaan 9. 

4. Hitung nilai anomali medan magnet dengan persamaan 10. 

 

C. Membuat Kontur Anomali Medan Magnet 

1. Buka software Surfer 12 pilih File ➔ New ➔ Worksheet. 

2. Setelah muncul worksheet baru, masukkan data dengan format kolom A = 

koordinat x, kolom B = koordinat y, kolom C = nilai anomali medan magnet. 

Kemudian simpan dalam ekstensi .txt. 

3. Buka plot pada software Surfer 12 kemudian pilih Grid ➔ Data kemudian pilih 

file koordinat x dan y serta anomali medan magnet yang disimpan dalam ekstensi 
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.txt tadi. Setelah muncul dialog Grid Data, pada Gridding Method pilih Krigging 

kemudian klik OK. Tunggu hingga proses gridding selesai. File grid telah 

tersimpan otomatis. 

4. Kemudian pilih Map➔ New ➔ Contour Map pilih file hasil gridding tadi hingga 

muncul tampilan seperti pada Gambar L17. 

 
Gambar L17. Tampilan Awal Kontur Anomali Medan Magnet. 

 

5. Untuk mengedit kontur anomali agar mudah diinterpretasikan, pada kotak 

Object Manager pilih Contours. Kemudian pada Property Manager pilih Level 

kemudian kontur anomali medan magnet dapat diedit sesuai keinginan.  Kontur 

anomali yang telah diedit ditunjukkan pada Gambar L18. 
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Gambar L18. Tampilan Kontur Anomali Medan Magnet Setelah Diedit.  

 

D. Reduksi Ke Kutub 

1. Sebelum membuka software Oasis Montaj untuk melakukan proses reduksi ke 

kutub, terlebih dahulu membuat file anomali medan magnet agar dapat terbaca 

di software ini. Caranya dengan menyalin data pada Microsoft Excel dengan 

format kolom A = koordinat x, kolom B = koordinat y, kolom C = nilai anomali 

medan magnet.  

2. Setelah itu buka software Notepad kemudian pilih Edit ➔ Paste. Simpan data 

dalam ekstensi .txt. 

3. Buka software Oasis Montaj pilih File ➔ Project ➔ New kemudian akan 

muncul dialog seperti pada Gambar L19. Pada kolom File Name beri nama file 

dan pilih tempat penyimpanan file kemudian klik Save. 
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Gambar L19.  Membuat Project Baru pada Software Oasis Montaj. 

4.  Kemudian pilih Data ➔ Import ➔ Ascii untuk mengimport data. Maka akan 

muncul kotak dialog Import Wizard seperti pada Gambar L20. Pilih data anomali 

medan magnet dalam ekstensi .txt tadi. Pilih Wizard kemudian pilih Next untuk 

Data Import Wizard Step 1-2. 

 

Gambar L20. Mengimport File Anomali Medan Magnet. 
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5. Pada Data Import Wizard Step 3 of 3, klik kolom pertama kemudian isi pada 

bagian Parameters. Channel name diisi Easting dan Label diisi X seperti pada 

Gambar L21. Setelah itu klik kolom kedua Channel name diisi Northing dan 

label diisi Y. Kemudian klik kolom ketiga Channel name diisi Anomaly dan label 

diisi Z. Kemudian klik Finish. 

6. Kemudian simpan template. Pada bagian Import file pilih file anomali medan 

magnet yang disimpan dalam ekstensi .txt. Pilih OK.  

7. Setelah itu akan muncul kotak dialog Create New Database, Pada bagian New 

Databasde Name isi dengan nama database yang diinginkan dan dimana 

database akan disimpan. Pilih OK. Tampilan jika telah selesai import data 

ditunjukkan pada Gambar L22. 
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Gambar L21. Memberi Nama Channel dan Label. 

 

 
Gambar L22. Tampilan Setelah Selesai Import Data 

 

 

8. Selanjutnya untuk mengatur koordinat yang digunakan, pilih menu Coordinates 

➔ Change X,Y Coordinates maka akan muncul kotak dialog Set Current X,Y 

Channels seperti pada Gambar L23.  

 
Gambar L23. Mengatur Koordinat 
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9. Langkah selanjutnya yaitu membuat grid dari anomali medan magnet dengan 

pilih menu Grid➔ Gridding ➔ Minimum Curvature ➔ Dialog Controls. Maka 

akan muncul kotak dialog Minimum Curvature Gridding. Pada bagian Channel 

to Grid pilih Anomali. Beri nama file grid dan letak penyimpanannya pada 

bagian Name of New Grid File. Pilih OK. Maka akan muncul hasil grid file 

seperti pada Gambar L24. 

 
Gambar L24. Tampilan Hasil Grid File 

10. Selanjutnya dilakukan proses untuk memunculkan menu MAGMAP pada Oasis 

Montaj yaitu dengan pilih menu GX ➔ Load menu. Setelah muncul kotak 

dialog Load menu pilih magmap.omn. Pilih Open. Maka menu MAGMAP akan 

muncul seperti pada Gambar L25. 
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Gambar L25. Memunculkan Menu MAGMAP. 

 

11. Untuk memulai proses Reduce To Pole (RTP) dilakukan tahap preparasi grid, 

dengan cara pilih menu MAGMAP ➔ Step by Step Filtering ➔ Prepare Grid. 

Maka akan muncul kotak dialog FFT2 grid pre-processing. Pada bagian Name 

of Input Grid File isi dengan file hasil dari  langkah ke- 9. Kemudian beri nama 

output pada Name of Output Grid File dan pilih tempat penyimpanannya 

seperti pada Gambar L26. Kemudian klik Start maka akan muncul hasilnya 

seperti pada Gambar L27. 

12. Kemudian dilakukan proses forward FFT dengan cara pilih MAGMAP ➔ Step 

by Step Filtering ➔ Forward FFT maka akan muncul kotak dialog FFT2IN 

pilih nama output hasil dari langkah 11 tadi. Pilih OK. 

13. Selanjutnya pilih menu MAGMAP ➔ Step by Step Filtering ➔Define Filters 

maka akan muncul kotak dialog MAGMAP FILTER DESIGN pilih OK. Dan 

pada First Filter to Apply pilih Reduce To Magnetic Pole. Kemudian masukkan 

nilai inklinasi serta deklinasi daerah penelitian. Pilih OK. 
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Gambar L26. Menyimpan Hasil Preparasi Grid. 

 

 
Gambar L27. Tampilan Hasil Preparasi Grid. 

 

14. Selanjutnya pilih menu MAGMAP ➔ Step by Step Filtering ➔Apply Filter. 

Pada kotak dialog bagian Name of Input Transform File pilih file hasil output 

dari langkah ke-9. Kemudian beri nama output dan letak penyimpanan pada 
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bagian Name of Output. Pilih OK. Maka akan muncul hasil RTP seperti pada 

Gambar L28. 

 
Gambar L28. Hasil Reduksi Ke Kutub. 

 

E. Kontinuasi Ke Atas 

1. Masih pada software Oasis Montaj dipilih menu MAGMAP➔Interactive 

Filtering➔Prepare Grid maka akan muncul dialog FFT2 grid pre-processing. 

Pada kolom Name of Input (Original) Grid File diisi file hasil RTP. Pada kolom 

Name of Input (Original) Grid File isikan nama file output yang diinginkan. Pilih 

Start. 

2. Kemudian pilih lagi menu MAGMAP➔Interactive Filtering➔Forward FFT 

maka akan muncul dialog FFT2IN pada kolom Name of Input pre-processed 

Grid File pilih file hasil pengolahan langkah 1. Pilih OK. 

3. Selanjutnya pilih menu MAGMAP➔Interactive Filtering➔Radial Average 

Spectrum maka akan muncul dialog FFT2RSPC. Pada kolom Name of Input 

Transform (grid) File pilih file hasil pengolahan langkah 1. Pada kolom Name 
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of Output Spectrum File isikan dengan nama output yang diinginkan dan pilih 

tempat penyimpanan file dengan klik Browse. Pilih OK. 

4. Pilih menu MAGMAP➔Interactive Filtering➔Interactive Spectrum Filters 

maka akan muncul kotak Interactive Spectral Filter. Pada bagian Filters kolom 

Filter Name pilih Upward Continuation Filter maka akan muncul kolom 

Continuation distance isikan ketinggian yang diinginkan. Untuk melihat 

perubahan anomali medan magnet setelah dilakukan proses kontinuasi ke atas,  

pilih Preview maka akan muncul tampilan seperti pada Gambar L29. Setelah itu 

pilih OK. 

 
Gambar L29. Tampilan Preview Hasil Kontinuasi ke Atas. 

 

5. Pilih menu MAGMAP➔Interactive Filtering➔Apply Filter maka akan muncul 

dialog FFT2FLT. Pada kolom Name of Input Transform File pilih file hasil dari 

langkah 1. Pada kolom Name of Output Grid File isikan nama file output yang 



 

154 
 

diinginkan. Pada kolom Name of Reference (Original) Grid File pilih file hasil 

proses RTP. Pilih OK, maka akan muncul hasil proses kontinuasi ke atas seperti 

pada Gambar L30. 

 
Gambar L30. Tampilan Hasil Proses Kontinuasi Ke Atas 

 

F. Pemodelan 2D 

1. Sebelum dilakukan pemodelan 2D, terlebih dahulu dilakukan proses untuk 

memunculkan menu MAGMAP pada Oasis Montaj yaitu dengan pilih menu GX 

➔ Load menu. Setelah muncul kotak dialog Load menu pilih gmsys.omn. Pilih 

Open. Maka menu GM-SYS akan muncul. 

2. Selanjutnya pilih meu GM-SYS➔New model➔From map profile maka akan 

muncul dialog Create a GM-SYS model from a map profile. Pada kolom Model 

Name isikan nama yang diinginkan dan file tempat penyimpanan file dengan klik 

pada Browse. Pada kolom Magnetic grid pilih output hasil kontinuasi ke atas. 
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Pada kolom Magnetic elevation grid pilih file grid ketinggian daerah penelitian. 

Pilih Finish. 

3. Kemudian dilakukan proses penyayatan dengan menarik garis melalui target 

penelitian kemudian klik kanan pilih Done seperti ditunjukkan pada Gambar 

L31. 

 
Gambar L31. Proses Penyayatan 

 

4. Setelah itu akan muncul dialog GM-SYS Model Recovery. Pilih Done. 

5. Selanjutnya pada dialog Earth’s Magnetic Field pada kolom Magnitude diisi 

dengan nilai medan magnet sesuai dengan daerah penelitian. Pada kolom 

Inclination diisi 90 karena kontur anomali telah dilakukan proses RTP. Pilih OK, 

maka akan muncul tampilan seperti pada Gambar L32. 

6. GM-SYS memiliki 2 bagian utama yaitu bagian atas yang merupakan bagian 

referensi dan bagian bawah yang merupakan bentuk model. Bagian atas 

menunjukkan nilai anomali medan magnet. Bagian bawah pemodelan 

menunjukkan struktur batuan. Garis merah pada bagian referensi merupakan 
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indikator error. Pembuatan model sebisa mungkin membuat garis merah dapat 

berhimpit dengan garis biru, dan garis hitam bisa mengikuti titik-titik hitam, 

sehingga nilai error menjadi kecil. 

 
Gambar L32. Tampilan Awal GM-SYS 

 

7. Kotak Action berisi alat-alat yang digunakan untuk pembuatan model. 

 

8. Untuk membuat blok batuan, pertama-tama pilih Add points pada kotak Action 

lalu tambahkan titik dengan menarik garis di antara dua titik pada garis merah. 

Kemudian hubungkan kedua titik pada garis merah tersebut dengan memilih 

bagian split block. Klik pada titik pertama, kemudian tarik garis menuju titik 

kedua, lalu klik pada titik kedua, tarik lagi ke titik pertama baru kemudian klik 

pada titik pertama. Pilih Accept new block, maka akan muncul tampilan seperti 

pada Gambar L33. 

9. Untuk memodifikasi atau membuat model dapat dilakukan dengan menambah 

titik, membuat blok baru, menghapus blok atau menyatukan blok-blok.  
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10. Untuk mengubah suseptibilitas blok batuan dilakukan dengan memilih 

examine pada kotak Action kemudian klik blok yang ingin diubah lalu klik 

panel A/C pada bagian suseptibilitas maka akan muncul kotak Susceptibility 

sebagai pengubah suseptibilitas. Pada bagian limits pilih linear. Ubah nilai 

suseptibilitas sampai sesuai atau nilai error mengecil seperti pada Gambar L34.  

 
Gambar L33. Tampilan Langkah Awal Pembuatan Blok Batuan Pada GM-SYS 

 

 

 
Gambar L34. Mengubah Nilai Suseptibilitas Blok Batuan 
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11. Mengubah satuan suseptibilitas dapat dilakukan dengan pilih menu Display ➔ 

Anomaly Units➔ pilih sesuai keinginan. 

 

G. Pemodelan 3D 

1. Pada software Oasis Montaj, buka file kontur anomali medan magnet yang sudah 

di RTP. 

 

2. Pilih menu Data ➔ New Database ➔ beri nama sesuai yang diinginkan ➔ OK. 

 

3. Pilih menu Grid ➔ Utilities ➔ Grid Profile. Pada bagian grid 1 dipilih peta 

yang mau disayat untuk pemodelan kedalaman, bagian New line name diberi 

nama untuk model kedalaman, kemudian pada bagian Sample Interval diisi 

sesuai dengan kebutuhan ➔OK ➔OK. 

 

4. Kemudian sayat dari ujung kiri ke ujung kanan. Penyayatan sebisa mungkin 

mencakup nilai terendah dan tertinggi dengan cara klik kiri kemudian tarik 

kursor sampai ujung sayatan lalu klik kiri satu kali lagi baru klik kanan. Pilih 

Done. 

 

5. Pilih menu Utility ➔ Make Distance Channel ➔ OK, maka akan muncul satu 

kolom lagi di bagian paling kanan. 

6. Pilih menu Export ➔ Other ➔ pilih format *.csv kemudian beri nama sesuai 

keinginan. 

7. Buka software Surfer ➔ File ➔ Open File kemudian pilih file dalam format 

*.csv yang tadi telah disimpan dari software Oasis Montaj. 
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8. Ubah kolom dari format | x | y | G atenuasi | distance | menjadi | x | y | distance | 

G atenuasi |. 

9. Pilih menu File ➔ Save As ➔ format *.DAT kemudian beri nama sesuai inginan. 

Pilih Save. 

10. Buka Software Oasis Montaj. Pilih menu Grid ➔ X-Utilities ➔ Fill Grid 

Dummies. Kemudian akan muncul kotak dialog Fill Grid Dummy Areas by 

Interpolation. Pada bagian Input Grid File masukkan file RTP yang belum 

diatenuasi. Pada bagian Output Filled Grid File beri nama file output sesuai 

keinginan. Pilih OK. 

11. Buka software Surfer. Pilih menu Map ➔ New ➔ Contour Map kemudian 

pilih  nama simpanan file dari software Surfer sebelumnya. 

12. Selanjutnya pada kotak Property Manager, pilih General ➔ Save kemudian 

pilih format *.dat. Buka worksheet, kemudian buka nama file simpanan dalam 

format *.dat sebelumnya. Salin kolom 1, 2, dan 3. 

13. Buka kembali plot pada langkah 12. Pada kotak Property Manager pilih 

General ➔Grid Info. Maka akan muncul kotak Grid Information. Pada bagian 

Grid Geometry, salin bagian X Minimum sampai Y spacing kemudian paste di 

Microsoft Excel lalu ubah satuan dari m menjadi km dengan dibagi 1000. 

X posit : X minimum Norm. Field : Rata-rata  IGRF  di 

Y posit : Y minimum    lokasi penelitian 

Z posit : 0 Inclin : Nilai inklinasi 
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14.  Buka software Magblox. Pilih Cancel. Pada bagian kiri bawah pilih 

Ignore. Lalu masukkan data sesuai keterangan berikut berdasarkan data 

yang telah diperoleh dari software surfer yang sudah disalin ke Ms. Excel: 

 

Untuk setiap langkah pengisian data harus selalu diakhiri dengan klik Update. 

Tampilan Magblox ditunjukkan pada Gambar L35. 

 

Gambar L35. Tampilan Software Magblox. 

X size : X maximum - X minimum Declin : Nilai deklinasi 

Y size : Y maximum - Y minimum 

X step : lebar blok X 

(sesuai   keinginan) 

Z size 

: kedalaman yang 

diinginkan 

Y step : lebar blok Y 

(sesuai keinginan) 

X divis : 6 (sesuai keinginan) X start : X minimum 

Y divis : 6 (sesuai keinginan) Y start : Y minimum 

Z divis : 6 (sesuai keinginan) X ending : X maximum 

Suscept : nilai   susptibilitas Y ending : Y maximum 

   rata-rata   
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15. Pilih Exit kemudian simpan dua kali dengan nama yang sama dalam format 

*.inp dan *.out. 

16. Selanjutnya buka kembali Software Surfer kemudian buka worksheet baru. 

Pada kolom  A baris pertama isikan nama file yang diinginkan (misal: model 

3d). Kosongkan baris kedua. Pada baris ketiga kolom A sampai dengan E 

isikan dengan format |jumlah data hasil RTP | 1 | 2 | 3 | 0 |. Kosongkan baris 

keempat. Pada baris kelima kolom A diisikan koordinat x dalam km, kolom B 

diisikan koordinat y dalam km, dan kolom C adalah nilai hasil RTP kemudian 

simpan dengan format *.dat. 

17. Buka software Magblox. Pilih Open kemudian buka format simpanan pertama 

dengan format *.inp pilih  menu File ➔ Read Data pilih file hasil langkah 16. 

Maka akan muncul tampilan seperti pada Gambar L36. 

 

Gambar L36. Tampilan Magblox Setelah Read Data. 
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18. Pada bagian Iters, diganti dengan berapa kali iterasi sesuai dengan kebutuhan 

kemudian pilih Compute➔ Optimize lalu tunggu sampai iterasi selesai. 

19. Pilih menu Exit ➔ OK ➔ Save dua kali dengan nama yang sama dalam 

format *.inp dan *.out. 

20. Buka software Bloxer. Pilih file hasil langkah 19. Pilih Open. Tampilan awal 

software Bloxer ditunjukkan pada Gambar L37. 

21. Pada bagian Editing pilih Edit single blocks kemudian ganti nilai pada kolom  

Value sesuai keinginan dengan terlebih dahulu klik kanan blok yang ingin 

diganti nilai suseptibilitasnya. Klik Edit params kemudian klik kiri pada blok 

kemudian klik kanan. 

 

 

Gambar L37. Tampilan Awal Software Bloxer. 
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22. Setelah selesai mengedit semua blok, pilih Save Model As kemudian simpan 

dalam format *.inp. 

23. Buka software Microsoft Excel kemudian drag file hasil software Bloxer yang 

dalam format *.blx ke sheet pada software Microsoft Excel lalu klik pada kolom 

A pilih Data ➔ Text To Columns ➔ Delimited ➔ OK. Lalu konversi satuan x 

dan y dari km menjadi m dengan dikalikan 1000. 

24. Buat sheet baru kemudian buat data dengan format | koordinat x (m) | koordinat 

x (m) | kedalaman (m) | Suseptibilitas| kemudian salin data ini. 

25. Buka software Rockwork. Paste data dari langkah 24 ke sheet pada software 

Rockwork seperti pada Gambar L38. 

26. Pilih menu Solid ➔ Model kemudian munculkan tanda (+) di semua poin lalu 

pilih Create New Model ➔ Solid Model Name lalu beri nama model 3D sesuai 

keinginan ➔ Process ➔ Yes ➔ OK maka akan muncul tampilan seperti pada 

Gambar L39. 
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Gambar L38. Pengisian Awal Data Untuk Pemodelan 3D. 

 

 
Gambar L39. Tampilan Awal Model 3D. 

 

27. Kemudian software Rockwork akan mengolah data menjadi model 3D. Untuk 

mempermudah dalam menginterpretasi, model dapat diputar dan disaring 
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berdasarkan nilai suseptibilitasnya yaitu dengan menggunakan teknik iso-level. 

Caranya yaitu dengan pada bagian Data➔klik kanan pada Solid Model ➔ 

Options. Pilih Iso-Level Value yang diinginkan. Pilih Apply. 
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Lampiran 5. Persamaan Kontinuasi ke Atas 

 Kontinuasi ke atas dilakukan dengan mentransformasikan medan potensial 

yang diukur pada permukaan tertentu menuju ke medan potensial pada permukaan 

lain yang lebih jauh dari sumber. Dengan begitu, semakin pendek panjang 

gelombangnya maka semakin besar kontinuasinya. Konsep dasar dari transformasi 

ini berasal dari identitas ketiga Teorema Green di mana teorema ini menjelaskan 

bahwa apabila fungsi U bersifat harmonik, kontinyu, dan mempunyai turunan yang 

kontinyu di sepanjang daerah R (Gambar 7), maka dapat dinyatakan dalam 

persamaan berikut (Blakely, 1996). 

𝑈(𝑃) =
1

4𝜋
∫ (

1

𝑟

𝜕𝑈

𝜕𝑛
− 𝑈

𝝏

𝜕𝑛

𝟏

𝒓
)

𝑆

 𝒅𝑺 (L1) 

Persamaan L1 menjelaskan prinsip dasar dari kontinuasi ke atas, bahwa 

suatu medan potensial dapat dihitung pada setiap titik di dalam suatu daerah 

berdasarkan sifat medan magnet pada permukaan yang melingkupi daerah tersebut, 

dengan S menunjukkan permukaan R, n menunjukkan arah normal keluar, dan r 

adalah jarak dari titik P ke suatu titik permukaan S. 

Dengan menggunakan koordinat kartesian, dengan sumbu z berarah ke 

bawah, diasumsikan bahwa suatu medan potensial diukur pada permukaan 𝑧 = 𝑧𝑜 

dan medan yang kita inginkan terletak pada suatu titik 𝑃𝑥,𝑦,𝑧𝑜−∆𝑧 yang berada di atas 

permukaan tersebut, di mana ∆𝑧 > 0. Gambar 7 merupakan gambar yang 

menyebutkan bahwa 𝑧 > 𝑧𝑜, apabila a menjadi besar, maka integrasi pada 

persamaan kontinuasi di seluruh hemisphere  menjadi kecil. Dengan demikian, jika 

a mendekati tak hingga maka persamaan  menjadi sebagai berikut. 
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𝑈𝑥,𝑦,𝑧𝑜−∆𝑧 =
1

4𝜋
∫ ∫ (

1

𝑟

𝜕𝑈𝑥,𝑦,𝑧𝑜−∆𝑧

𝜕𝑧
− 𝑈𝑥,𝑦,𝑧𝑜−∆𝑧

𝜕

𝜕𝑧

1

𝑟
)

∞

−∞

∞

−∞
𝑑𝑥′𝑑𝑦′  (L2) 

dengan 𝑟 = √(𝑥 − 𝑥′)2 + (𝑦 − 𝑦′)2 + (𝑧𝑜 − ∆𝑧 − 𝑧′)2 dan ∆𝑧 > 0. Oleh karena 

persamaan (L2) di atas sulit karena memerlukan nilai U pada permukaan dan nilai 

gradien vertikal U, maka perlu dilakukan eliminasi bagian pada persamaan di atas 

dengan identitas kedua Green. 

1

4𝜋
∫ [𝑉

𝜕𝑈

𝜕𝑛
− 𝑈

𝜕𝑉

𝜕𝑛
]

𝑧

𝑑𝑆 = 0 (L3) 

dengan substitusi persamaan (L3) ke persamaan (L1) maka dapat dituliskan 

menjadi berikut. 

𝑈(𝑃) =
1

4𝜋
∫ [(𝑉 +

1

𝑟
)

𝜕𝑈

𝜕𝑛
− 𝑈

𝜕

𝜕𝑛
(𝑉 +

1

𝑟
)]

𝑧

𝑑𝑆 (L4) 

Untuk mengeliminasi bentuk pertama, V harmonik diperlukan sehingga 𝑉 +
1

𝑟
= 0 

di setiap titik pada S. P’ adalah cerminan dari P pada 𝑥, 𝑦, 𝑧𝑜 + ∆𝑧 dan diberikan 

𝑉 +
1

𝜌
= 0, di mana: 

V yang memenuhi 𝑉 +
1

𝑟
 akan hilang pada hemisphere saat a membesar dan V selalu 

harmonik karena 𝜌 tidak akan pernah hilang. Maka persamaan (L5) dapat dituliskan 

sebagai berikut. 

𝑈(𝑃) =
1

4𝜋
∫ [(

1

𝑟
−

1

𝜌
)

𝜕𝑈

𝜕𝑛
− 𝑈

𝜕

𝜕𝑛
(

1

𝑟
−

1

𝜌
)]

𝑧

𝑑𝑆 (L6) 

Jika hemisphere menjadi besar, maka bagian pertama akan hilang di setiap titik 

pada S dan bagian kedua akan hilang kecuali pada permukaan horizontal. 

𝜌 = √(𝑥 − 𝑥′)2 + (𝑦 − 𝑦′)2 + (𝑧𝑜 + ∆𝑧 − 𝑧′)2 (L5) 
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𝑈𝑥,𝑦,𝑧𝑜−∆𝑧 = −
1

4𝜋
∫ ∫ 𝑈(𝑥′, 𝑦′, 𝑧𝑜)

𝜕

𝜕𝑧′
[
1

𝑟
−

1

𝜌
]

∞

−∞

∞

−∞

𝑑𝑥′𝑑𝑦′ (L7) 

 

dengan membawa turunan dan mengeluarkan z’ dari permukaan horizontal menuju 

ke persamaan (L8). 

𝑈𝑥,𝑦,𝑧𝑜−∆𝑧 = 

∆𝑧

2𝜋
∫ ∫

𝑈(𝑥′, 𝑦′, 𝑧𝑜)

[(𝑥 − 𝑥′)2 + (𝑦 − 𝑦′)2 + ∆𝑧2]
3
2

𝜕

𝜕𝑧′

∞

−∞

∞

−∞

𝑑𝑥′𝑑𝑦′, ∆𝑧 > 0 

  

(L8) 

Persamaan (L8) merupakan formulasi integral kontinuasi ke atas untuk 

menghitung harga medan di setiap titik pada suatu permukaan ke permukaan lain. 

Setiap titik permukaan yang baru, integral dua dimensi diselesaikan secara 

komputasi dengan cara membawa ke domain Fourier. Persamaan (L9) merupakan 

sebuah konvolusi dua dimensi. 

𝑈𝑥,𝑦,𝑧𝑜−∆𝑧 = ∫ ∫ 𝑈(𝑥′, 𝑦′, 𝑧𝑜)𝜓𝑢(𝑥 − 𝑥′, 𝑦 − 𝑦′, ∆𝑧)
∞

−∞

∞

−∞

𝑑𝑥′𝑑𝑦  (L9) 

dengan 

𝜓𝑢(𝑥, 𝑦, 𝑧_𝑜 − ∆𝑧) =
∆𝑧

2𝜋[(𝑥 − 𝑥′)2 + (𝑦 − 𝑦′)2]
3
2

 (L10) 

 Jika medan potensial U yang diukur pada permukaan 𝑧 = 𝑧𝑜 memenuhi 

ketidaksamaan ∫ |𝑓(𝑥)|𝑑𝑥 < 1
∞

−∞
 maka persamaan (L9) memiliki transformasi 

Fourier 𝐹[𝑈]. Representasi domain Fourier dari persamaan (L9) didapat dengan 
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mengubah kedua sisi persamaan (L9) ke domain Fourier dan menerapkan teorema 

konvolusi Fourier. 

𝐹[𝑈𝑢] = 𝐹[𝑈]𝐹[𝜓𝑢] (L11) 

dengan 𝐹[𝑈] adalah transformasi Fourier dari bidang kontinuasi ke atas dan 𝐹[𝜓𝑢] 

didapat dari persamaan (L10). Persamaan (L10) dapat dituliskan dalam bentuk 

sebagai berikut. 

𝜓𝑢(𝑥, 𝑦, ∆𝑧) = −
1

2𝜋

𝜕

𝜕∆𝑧

1

𝑟
 (L12) 

dengan 𝑟 = √𝑥2 + 𝑦2 + ∆𝑧2 

dan 

𝐹 [
1

𝑟
] = 2𝜋

𝑒|𝑘|(−∆𝑧)

|𝑘|
 (L13) 

Substitusi persamaan (L12) ke (L13) dapat dituliskan menjadi persamaan di bawah 

ini. 

𝐹[𝜓𝑢] = −
1

2𝜋

𝜕

𝜕∆𝑧
𝐹 [

1

𝑟
] (L14) 

 

𝐹[𝜓𝑢] = −
𝜕

𝜕∆𝑧

𝑒|𝑘|∆𝑧

|𝑘|
 (L15) 

 

𝐹[𝜓𝑢] = 𝑒−|𝑘|∆𝑧 

 

(L16) 
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Lampiran 6. Rasio Giromagnetik  

 Rasio giromagnetik adalah perbandingan antara momentum magnet pada 

sebuah partikel dengan momentum angularnya yang dirumuskan sebagai berikut. 

𝐺 =
𝑚

𝐿
 (L17) 

dengan G adalah gyromagnetic ratio, m adalah momentum magnet, dan L adalah 

momentum sudut. Nilai gyromagnetic rasio dari proton adalah sebagai berikut. 

𝐺 = 2,67522 × 108𝑠−1𝑇−1 (L18) 

𝐺 = 2,67522 × 10−1𝑠−1𝑛𝑇−1 (L19) 

Prinsip kerja PPM adalah mengukur frekuensi putaran proton dalam berpresesi. 

Untuk mengetahui nilai medan magnet terukur pada PPM dapat diperoleh dari 

persamaan berikut.  

𝑓 =
𝑚

2𝜋𝐿
𝑇 (L20) 

𝑓 =
𝐺

2𝜋
𝑇 (L21) 

dengan f adalah frekuensi presesi proton dalam Hz, T adalah nilai medan magnet 

terukur dalam nT. Dengan demikian, maka nilai medan magnet dapat diketahui dari 

persamaan berikut. 

𝑇 =
2𝜋

𝐺
𝑓 (L22) 

𝑇 =
2 × 3.14

2,67522 × 10−1 
× 𝑓 (s. nT.

1

s
) (L23) 

𝑇 = 23,487 𝑓 nT (L24) 
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Lampiran 7. Dokumentasi Pengambilan Data 
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